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Thank you for purchasing the Sigma BF.

 – Please read this manual carefully so that you will learn how 
to use the product correctly. Be sure to read the “SAFETY 
PRECAUTIONS”  on page 11  and “PRECAUTIONS 
FOR HANDLING” on page 16 before using your camera.

 – Please keep the instruction manual available whenever nec-
essary and refer to it if you have any questions.

 – For details on the warranty and after-sales service for this 
product, please check the Sigma website.
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COPYRIGHT, TRADEMARKS, AND LICENSES
Under copyright law, images recorded with this camera may 
not be used without the permission of the copyright owner, 
except for the purpose of personal enjoyment. Please note 
that some demonstrations, shows, exhibitions, etc. may restrict 
recording even for reasons of personal enjoyment.

 – DNG is a trademark or registered trademark of Adobe Sys-
tems Incorporated in the United States and/or other coun-
tries.

 – Other company and product names in this booklet are 
trademarks or registered trademarks of the respective com-
panies.

 – This product is licensed under the AVC Patent Portfolio Li-
cense, but not licensed for any use other than the personal 
or non-commercial use of the customer in connection with 
the activities described below.

 – The image information shall be recorded in compliance with 
the AVC standard (hereinafter referred to as “AVC video”).

 – The AVC video recorded by a consumer engaged in a per-
sonal activity, or the AVC video obtained from a licensed 
provider shall be played.

 – For details, please refer to the MPEG LA, L.L.C. website 
(http://www.mpegla.com).

For details on the open source software, please visit the Sigma 
website.

sigma-global.com/en/support/open-source-software.html
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Disposal of Electric and Electronic Equipment in Private 
Households
Disposal of used Electrical & Electronic Equipment (Applicable 
in the European Union and other European countries with sep-
arate collection systems)
This symbol indicates that this product shall not be treated as 
household waste.
Instead it shall be collected separately for the recycling of 
electrical and electronic equipment. If the new products are 
purchased, this product might be handed over to the distribu-
tor or the collection system of waste electrical and electronic 
equipment eventually. By ensuring this product is disposed of 
correctly, you will help prevent potential negative consequenc-
es for the environment and human health, which could other-
wise be caused by inappropriate waste handling of this prod-
uct or components of this product. If this product is disposed 
illegally, it might cause a possibility of penalties. For more 
detailed information about recycling of this product, please 
contact your local city office, your household waste disposal 
service or the shop where you have purchased the product.

The CE Mark is a Directive conformity mark of the European 
Community (EC).

SIGMA (Deutschland) GmbH
Carl Zeiss Str. 10/2, D 63322 Roedermark, Germany
Sales: 06074 / 865 16 0   Service: 06074 / 865 16 65
Support: 06074 / 865 16 88
E-Mail: info@sigma-foto.de
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To users in the UK (excluding Northern Ireland)
UK Importer: The following importer description applies to 
products imported into the UK directly by SIGMA Imaging (UK) 
Ltd.
SIGMA Imaging (UK) Ltd.
1 Little Mundells, Welwyn Garden City, Hertfordshire, AL7 1EW

SIGMA C361
Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE

SIGMA CORPORATION OF AMERICA
15 Fleetwood Court, Ronkonkoma, NY 11779, U.S.A.
TEL: 631 585 1144

This device complies with Part 15 of the FCC Rules. Operation 
is subject to the following two conditions: (1) This device may 
not cause harmful interference, and (2) this device must ac-
cept any interference received, including interference that may 
cause undesired operation.

For customers in the U.S.A.
Federal Communications Commission (FCC) Radio Frequency 
Interference Statement
This equipment has been tested and found to comply with the 
limits for class B digital devices, pursuant to Part 15 of the 
FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installa-
tion. This equipment generates, uses and can radiate radio fre-
quency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio com-
munications. However, there is no guarantee that interference 
will not occur in a particular installation. If this equipment does 
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cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, 
the user is encouraged to try to correct the interference by one 
or more of the following measures:

 – Reorient or relocate the receiving antenna.
 – Increase the separation between the equipment and receiv-
er.

 – Connect the equipment into an outlet on a circuit different 
from that to which the receiver is connected.

 – Consult the dealer or an experienced radio/TV technician 
for help.

Use of interface cable is required to comply with class B limits 
in Subpart B of Part 15 of FCC Rules.
Any changes or modifications to this equipment not specified 
in this manual may void your warranty.

For customers in the Canada
This Class B digital apparatus complies with Canadian ICES-
003.
Cet appareil numérique de la classe B est conforme à la norme 
NMB-003 du Canada.

Australian RCM
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CHECKING THE CAMERA AND ACCESSO-
RIES
Before using the camera, please check that you have all of 
the following items. If any of the following items are missing, 
please contact the store where you purchased the camera.

1. BF Camera Body
2. Body Cap (on the camera)
3. Li-ion Battery BP-81
4. Start Guide
5. Booklet
6. Limited Warranty
7. Warranty Sticker
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SAFETY PRECAUTIONS
To avoid causing damage or injury, please read this instruc-
tion manual carefully, before using the camera. Please take 
special note of the following two cautionary symbols.

Warning !!
Using the product and disregarding this 
warning sign may cause serious injury or 
other dangerous results.

Caution !!
Using the product disregarding this caution 
sign may cause injury or damage.

This symbol denotes a warning or point, where caution 
is required.

This Symbol contains information regarding the actions 
that must be avoided.

 WARNING (BATTERY)
FAILURE TO FOLLOW THE WARNINGS, CAUTIONS, AND 
PROHIBITIONS MAY RESULT IN EXPLOSION, LEAKAGE, 
OR FIRE.

Do not use any battery other than that specified in the 
instruction manual.

Do not use the battery in any equipment other than that 
specified.

If you want to charge the battery by itself, use the dedi-
cated battery charger (sold separately).

Store the battery in a cool, dry place. Do not expose to 
rain or moisture.

Do not expose the battery to direct sunlight or near fire.

Do not charge, use, or store the battery in places with 
extremely low air pressure.



12

Do not subject the battery to strong impacts or vibra-
tions or throw it.

Never disassemble or modify the battery.

Do not short-circuit the battery with metal pieces or 
other objects.

Discontinue use if you notice any abnormalities with the 
battery, such as swelling.

 WARNING (BATTERY) OTHERS

Keep batteries away from children. Replace batteries 
with adult supervision always.

If for some reason, the camera or batteries emit smoke, 
or if overheating or the smell of burning is detected, 
remove the batteries, taking care to avoid being burned. 
Take the camera to an authorized Sigma service station.

When disposing of a battery, make sure it is completely 
discharged and insulate the contacts with tape or similar. 
Please follow all guidelines, rules and regulations of your 
community regarding the disposal of batteries. 

If you do not use the camera for a long period of time, 
remove the battery. This may cause the battery to leak 
and damage the camera.

If any fluid leaking from the battery comes into contact 
with your skin or clothes, immediately wash it off with 
clean water to avoid skin rashes.
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 WARNING (ABOUT THE BUILT-IN BATTERY)

 WARNING

 – INGESTION HAZARD: This product contains 
a button cell or coin battery.  

 – DEATH or serious injury can occur if ingested.  
 – A swallowed button cell or coin battery can 
cause Internal Chemical Burns in as little as 2 
hours.  

 – KEEP  new and used batter ies OUT OF 
REACH of CHILDREN  

 – Seek immediate medical attention if a battery 
is suspected to be swallowed or inserted in-
side any part of the body.

Remove and immediately recycle or dispose of used batteries 
according to local regulations and keep away from children. Do 
NOT dispose of batteries in household trash or incinerate. 
Even used batteries may cause severe injury or death. 
Call a local poison control center for treatment information. 
Do not force discharge, recharge, disassemble, heat above 
(manufacturer’s specified temperature rating) or incinerate. 
Doing so may result in injury due to venting, leakage or explo-
sion resulting in chemical burns. 

Product contains an non-replaceable battery. 
Battery type: MS621T
Nominal voltage: 3.0V
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 WARNING (CAMERA)

Never use your camera in an environment where flam-
mable or burnable, gas, liquids or chemicals, such as 
Propane, Gasoline, etc., are present.

Keep the camera in a safe place that children cannot 
reach. Playing with the camera strap around one’s neck 
can cause strangulation.

Do not disassemble the camera; Doing so can cause 
electric shocks and burns.

Do not touch internal parts of the camera that become 
exposed as a result of damage, it could cause fire or 
electric shock. Remove the batteries and contact an 
authorized Sigma service station.

Do not look at the sun with the lens of your camera; 
otherwise you could lose your eyesight.

Keep the camera away from moisture or water. If you 
drop your camera/lens in water, please contact an 
authorized Sigma service station. If you use the camera 
with this condition it can cause electric shock or fire.

Prevent water, or metallic and other conductive objects 
from coming into contact with the terminals of the cam-
era body. This can result in electric shock, overheating 
and fire.
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 CAUTION (CAMERA)

Do not leave the camera without the lens cap in place. 
Light entering through the lens for long periods of time 
could cause damage to the camera.

Please do not carry your camera while a tripod is at-
tached, as this could result in injury or a fall.

Please do not grasp the camera with wet hand, as it 
might cause electric shock

Do not leave the camera in a hot place or in a car parked 
in the sun. If the camera becomes hot, it might cause 
burns to the skin.

If the liquid crystal display (LCD) monitor becomes 
damaged, be careful of the fragments of glass, which 
can cause injury. Also, please be careful not to touch the 
liquid inside the LCD monitor or get it in your eyes or 
mouth.
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PRECAUTIONS FOR HANDLING
Before use
Before taking important photos, be sure to check and take 
test photos in advance to make sure that the camera is 
working properly. We cannot compensate for expenses in-
curred when shooting or any loss of profits that could have 
been gained from shooting.
We recommend bringing multiple fully charged batteries 
when traveling for extended periods, shooting outdoors, 
shooting in cold environments, shooting movies, or taking a 
large number of photos.

OPERATING ENVIRONMENT AND PRECAUTIONS
 – The camera is a precision instrument. Do not bump or drop 
it.

 – This camera is dust-proof and splash-proof so it can be 
used in light rain, however, it is not waterproof. When using 
this camera near water, be careful to avoid excessive expo-
sure to water. If water gets inside the camera, it may cause 
serious damage and become irreparable.

 – Do not leave the camera in a dusty or hot and humid loca-
tion (especially inside a car during the day) for long periods 
of time.

 – When taking the camera from a cold location into a warm 
room, water droplets may form on the camera. Place the 
camera in a plastic or other type of bag and adjust to the 
surrounding temperature before using it.
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 – This camera can be used in temperatures between 0°C and 
+40°C, and at humidity levels below 85% (no condensa-
tion). The battery performance decreases if the temperature 
drops below 0°C. In cold locations, we recommend that you 
carry a spare battery and use it alternately while putting it in 
your pocket to keep it warm.

 – The camera may occasionally stop working due to a static 
electricity and magnetic fields. In such a case, remove the 
battery and reinsert it. The camera may not function prop-
erly in locations containing strong radio waves or magnetic 
fields.

PRECAUTIONS FOR LONG-TERM SHOOTING
 – The surface of the camera may become hot, however, this is 
not a malfunction.

 – If you shoot a movie or take continuous pictures for long 
periods of time, it may cause the sensor to heat up and 
subsequently reduce image quality. If a warning mark (
) is displayed in the header, you should change the shutter 
speed and ISO settings so that the warning mark disap-
pears, or turn off the camera and wait for the temperature 
to drop before shooting again.

 – When the camera temperature rises, the warning mark (
) is displayed. If the temperature rises further, a message 
is displayed and the camera turns off. To allow the temper-
ature to drop sufficiently, leave the camera for at least 10 
minutes.
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ABOUT THE LCD MONITOR
 – The LCD monitor may have some pixels that are always 
turned on or always turned off due to its characteristics, 
however, this is not a malfunction. This does not affect the 
recorded data. Please note the above.

 – Due to the characteristics of the LCD, the display response 
may be slower in low temperatures. Also, the display may 
turn black at high temperatures, but will return to normal if it 
reaches room temperature.

ABOUT THE LENSES
This product uses the L-Mount. Your camera can use inter-
changeable lenses for L-Mount.

 – The Sigma BF has a 35mm full-frame image sensor. In order 
to take full advantage of the capability of the image sensor, 
it is recommended that L-Mount lenses are used for full size 
format. You can use lenses for APS-C format in DC Crop 
mode, which limits the recording area of the image sensor 
for APS-C size.

 – Sigma MC-21 Mount Converter (optional) allows you to use 
Sigma SA mount interchangeable lenses or Sigma inter-
changeable lenses for Canon EF mount.

 – Depending on the release date of the lens, updating the lens 
firmware may be required. It may also be necessary to up-
date the camera firmware. Please check our website for the 
latest information about the corresponding lens.
sigma-global.com/en/

 – Please note that attaching third-party products that do not 
comply with L-mount standards may cause camera malfunc-
tion.
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ELECTRONIC SHUTTER
This product is not equipped with a mechanical shutter mecha-
nism. It uses an electronic shutter that electrically controls the 
image sensor to adjust the exposure time.
The electronic shutter has advantages of being silent and 
having no vibrations, and enables faster continuous shooting. 
However, the electronic shutter has disadvantages, so be sure 
to note the following points.

 – Uneven exposure can easily occur under a flickering light 
source such as a fluorescent light, so use the slower shutter 
speed.

 – When shooting a fast-moving subject, distortion may occur.

CARE INSTRUCTIONS
 – When cleaning the body or lens, never use organic solvents 
such as thinner or benzene as they will damage the surface 
finish. Gently wipe the body and lens barrel using a soft, 
clean cloth. Gently blow any dust off the lens surface using 
a commercially available blower. If fingerprints or other 
marks are left on the lens, carefully wipe them off using a 
commercially available lens cleaner.

 – If dust or debris has adhered to the LCD monitor, blow it off 
using a commercially available blower. If the monitor is very 
dirty, wipe it gently using a soft, clean cloth.
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CLEANING THE DUST PROTECTOR
Blow away any dust on the dust protector (image sensor pro-
tection glass) using a blower. If there are any fingerprints on 
the glass of the dust protector, first blow away any dust using 
a blower, then gently wipe it using a soft, clean cloth. If any 
stubborn stains or dust remains, contact our service station for 
cleaning services.

WARNING
 – Do not use an aerosol compressed air cleaner. Liquid squirts 
depending on the injection angle, which may damage the 
dust protector.

 – Please do not use the blower with a brush. If a brush is at-
tached, it may scratch the dust protector.

STORAGE
 – If you will not be using the camera for a long period of time, 
remove the battery to prevent the camera from being dam-
aged due to leakage of battery acid.

 – Store the camera in a dry, well-ventilated place to prevent 
mold and rust from forming. It is also worthwhile storing the 
camera in a plastic bag containing desiccant. However, the 
desiccant has an expiration date, so please replace it from 
time to time. Do not store the camera together with insect 
repellents such as naphthalene, as they will have a detri-
mental effect on the camera.
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DESCRIPTION OF THE PARTS
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1 Lens Signal Contacts
2 Lens Mount Index / Lens Lock Pin
3 Lens Lock Button
4 Strap Holes
5 Speaker
6 Lens Mount
7 Image Sensor / Dust Protector
8 Battery Compartment
9 Battery Removal Lever
10 Tripod Socket
11 Microphone (Right)
12 Microphone (Left)
13 USB Port (USB3.0, Type-C)
14 Focal Plane Mark
15 LCD Monitor / Touch Panel
16 Shutter Button
17 Status Monitor
18 Dial
19 (Center) Button
20 (Option) Button
21 (Playback) Button
22 (Power) Button

CAUTION
 – Be careful not to touch the dust protector (image sensor 
protective glass) (7).
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DIAL AND OPERATION BUTTONS
 – The dial also functions as a directional button. In this manu-
al, each position is represented by , , , or .

1. Status Monitor
2. (Center) button
3. (Up) button
4. (Down) button
5. (Left) button
6. (Right) button
7. (Playback) button
8. (Option) button
9. (Power) button

 – The up and down operations of the directional button are 
represented by , the left and right operations are repre-
sented by , and the up, down, left and right operations 
are represented by .

 – Each position button on the dial and the button, but-
ton, and button can be operated in two ways: by touch-
ing or pressing.
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HEADER VIEW
When operating the button or in Record mode, various 
information is displayed at the top of the screen.

HEADER VIEW WHEN OPERATING THE BUTTON
IN STILL IMAGE MODE

1. Battery power level indicator
2. Time display
3. Shootable shot count display

IN RECORD MODE

1. Battery power level indicator
2. Standby display
3. Time display
4. Remaining recording time display

CAUTION
 – In Record mode, if the Options menu “SHOOTING INFOR-
MATION”(P.118) is set to OFF, nothing will be displayed 
except the standby display. If you want to display all infor-
mation, set “Shooting Information” to ON.
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PREPARATION

TO ATTACH THE HAND STRAP
This product does not come with a hand strap. If you want to 
use a hand strap, please purchase the dedicated hand strap 
HS-11B or HS-11G, sold separately.
Attach the hand strap to the strap hole.
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TO CHARGE THE BATTERY
Insert the included dedicated lithium-ion rechargeable battery 
“Battery Pack BP-81” (hereafter referred to as the battery) into 
the camera, and charge it using a commercially available USB 
AC adapter or computer. The battery is not charged when pur-
chased. Please charge it before use.

1
Insert the battery into the battery compartment of the camera.

2
To charge, connect the camera to a commercially available 
USB AC adapter or computer using a commercially available 
USB Type-C cable.

 – During charging, the battery charge status (remaining bat-
tery power level) is displayed on the status monitor.
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 – When a USB PD adapter (9V/3A) is used, the charging time 
is approximately two to three hours.

 – The charging time varies depending on the adapter and 
computer specifications.

 – When the battery power level reaches 100%, charging is 
complete, and the status monitor turns off.

 – This camera supports USB PD (USB Power Delivery). We 
recommend a USB PD adapter compatible with the 9V/3A 
output.

 – When charging with a USB PD adapter, use a USB Type-C 
cable compatible with 3A.

CAUTION
 – If the number of images that can be taken on a single charge 
is significantly reduced, the battery is reaching the end of its 
lifespan. Replace it with a new one.

 – Do charging in a location between 0°C and 45°C.
 – The charging time will be longer in low temperatures (below 
10°C).

 – When connecting to a computer, be sure to connect to the 
USB port on the computer body. Do not connect it to the 
USB socket of a monitor, keyboard, or USB hub.

 – If the computer enters Sleep mode during charging, charg-
ing may be stopped.

TIP
 – When the battery is connected to an AC adapter or com-
puter, power is supplied to the camera at the same time as 
it charges, allowing you to operate the camera. (Keep the 
battery in the camera.)

 – The battery can be charged with BC-81 battery charger 
(optional). (P.169)
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HOW TO REMOVE THE BATTERY
Slide the battery release lever to remove the battery.

WARNING
 – Never remove the battery while images are being written or 
transferred. Otherwise, image files may be lost.

Image writing sign
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MOUNTING AND REMOVING THE LENS
1
Turn the camera off.

2
Remove the lens rear cap and the camera body cap.

 – To remove the body cap, turn it counterclockwise while 
pressing the lens release button.

3
Align the lens mount index on the camera with the index on the 
lens. Insert the lens into the mount of the camera and rotate 
the lens clockwise until it clicks into the locked position.

CAUTION
 – To ensure the lens fits correctly, do not press the lens lock 
button while attaching the lens. Make sure that the lens is 
locked in place.
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To remove the lens, press the lens lock button and turn the lens 
counter-clockwise until it stops. Gently remove the lens from 
the camera body.

CAUTION
 – On the mount surface of the lens, there are a number of 
electrical contacts. Scratches or dirt may cause the camera 
to malfunction.
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TURNING THE POWER ON/OFF
This section describes how to operate the (power) button 
and the mode that reduces the rate of battery consumption.

WHEN THE CAMERA TURNS OFF:
Press the button to turn the power on.

WHEN THE CAMERA IS TURNED ON:
Short-press (*1) the button to shift to Sleep mode*.
Long-press (*2) the button to turn the camera off.

(*1) Short-press: Press for about 0.2 seconds.
(*2) Long-press: Press for about one second.

* SLEEP MODE
If the camera is not operated for a certain period of time, it 
enters Sleep mode, and the LCD monitor turns off, thereby, 
reducing the rate of battery consumption.

 – During Sleep mode, the battery power level is displayed on 
the status monitor.
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TIP
 – The time until the camera shifts into Sleep mode can be 
changed in the “Sleep Timer”(P.123) in the “Monitor Set-
tings” option menu.

WHEN THE CAMERA IS IN SLEEP MODE:
Short-press (*1) the button or half-press the shutter button 
to return to the mode before Sleep mode.
Long-press (*2) the button to turn the camera off.

AUTO POWER OFF
When the camera has been in Sleep mode for about five min-
utes, it turns off to reduce the rate of battery consumption.

CAUTION
 – When the camera enters Auto Power Off mode, the status 
before Sleep mode is cleared.

TIP
 – If you turn the camera on while it remains connected to a 
computer, the “USB Mode Select” screen is displayed. If 
you want to continue using the camera by charging or with a 
USB power supply, select “Cancel” and press the button.



33

CONFIGURING THE INITIAL SETTINGS
When you turn the camera on for the first time after purchas-
ing it, configure the initial camera settings.
SETTING THE LANGUAGE
Use the button to select your desired language, and press 
the button.

SETTING THE DISTANCE UNIT
Use the button to select M (meters) or FEET, then press the 

button.

SETTING THE TIME ZONE
Use the button to select the area you want to use, then 
press the button.

SETTING THE DATE/TIME
Press the button, use the button to set the date and 
time, then press the button.

 – Set “Summer Time”, “Date Format” and “24-Hour Time” 
as necessary.

Select “OK” and press the button to complete the initial 
settings.

 – The items set on the Initial Settings screen can be changed 
later in each item in the “System Menu”.
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CHECKING THE BATTERY POWER LEVEL
Touch the button to display the battery power level in the 
header. Always be sure to check the battery power level before 
and while using the camera.

Fully charged.

The battery power level is low, and the 
camera will soon stop working. Charge or 
replace the battery.

The battery power level is low, and the 
camera will soon stop working. Charge or 
replace the battery.

Under charging

 – While the battery is charging or in sleep mode, the battery 
power level is displayed on the status monitor.

Sleep mode

Under charging
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CAUTION
 – When a USB storage such as an SSD is attached, the rate 
of battery consumption increases, and the battery power 
level display changes.

 – The battery power level may temporarily drop at low and 
high temperatures.

TO OPERATE THE TOUCH PANEL
Some functions can be operated using the touch panel (touch 
sensor on the LCD monitor).

The touch operations are described below:

Tap
Touch lightly with your finger and then raise 
your finger.

Drag
Touch and then move your finger while still 
touching.

Flick
Touch and move your finger rapidly while 
still touching.

Pinch Out
Touch with two fingers and then move 
fingers further apart.

Pinch In
Touch with two fingers and then move 
fingers closer together.
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HOW TO PRESS THE SHUTTER BUTTON
The focus function is activated at a position where you press 
the shutter button lightly to stop (half-press). Press it further 
(full-press) to take the picture.

QUICK PREVIEW
To review an image immediately after shooting, touch the 
button.

 – If you touch the button during live view, the last image 
captured is displayed.

 – For a movie, the first frame is displayed.
 – Press the button to switch to Playback mode.
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DOING THE SHOOTING

TAKING A PICTURE
The general procedure to follow to take a picture is as follows.

SELECT THE DRIVE MODE.(P.57)
SELECT THE RECORD FORMAT. (P.93)
DETERMINE THE EXPOSURE. (P.41)
FOCUS THE CAMERA. (P.67)
PRESS THE SHUTTER BUTTON TO TAKE A PICTURE.

 – For information about other settings, refer to the appropri-
ate pages.
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SHOOTING A MOVIE
The general procedure to shoot a movie is as follows.

SET THE DRIVE MODE TO “VIDEO” AND SELECT THE 
RECORD FORMAT. (P.93)
SELECT THE RESOLUTION AND FRAME RATE. (P.99)
DETERMINE THE EXPOSURE. (P.41)
FOCUS THE CAMERA.(P.67)
PRESS THE SHUTTER BUTTON TO START SHOOTING.
During Movie Shooting...
A red line is displayed on the status monitor.

The time display in the header changes to the recording time 
display (red).

PRESS THE SHUT TER BUT TON AGAIN TO STOP 
SHOOTING.

 – For information about other settings, refer to the appropri-
ate pages.

CAUTION
 – The maximum length of time a movie can be recorded using 
a single shooting operation is two hours even if there is suf-
ficient free space on the internal storage for a longer period.
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MAIN MENU
Configure the main shooting settings, such as the exposure 
and Drive Mode, in the main menu.

Press the button during the live view to display the main 
menu.

1. Drive Mode
2. Record Format
3. Aspect Ratio + DC Crop Mode
4. Focus Mode
5. White Balance
6. Exposure area
7. Color Mode
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WHEN THE DRIVE MODE IS SET TO RECORD, THE TOP 
OF THE MAIN MENU IS DISPLAYED AS FOLLOWS.

8. Record Format
9. Resolution + Frame rate
10. DC Crop mode (Crop ratio display)
11. Image Stabilization
12. Focus Mode
13. White Balance

IN THE MAIN MENU:
 – Use the  button to move the cursor left or right, and use 
the  button to move the cursor between the upper and 
lower rows. (You can also hold down the  button to move 
the cursor between the upper and lower rows.)

 – Move the cursor to the desired item and turn the dial to 
change the settings.

 – Move the cursor to the desired item and press the  but-
ton to transition to the respective setting screen.

 – If you half-press the shutter button, the main menu disap-
pears, but the item pointed by the cursor is displayed on the 
status monitor. You can change items and settings while 
watching the status monitor.
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DETERMINING THE EXPOSURE
Set in the Exposure area of   the main menu.

SETTING SCREEN

1. Shutter Speed
2. Aperture
3. Exposure Compensation / Exposure Meter Display
4. ISO Sensitivity
5. Histogram

1
Use the buttons to move the cursor to one of the elements 
you want to change the settings for (Shutter Speed, Aperture, 
ISO Sensitivity) and press the button.

2
Use the  button to move the cursor to the lower row, then 
use the dial to set the value.
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3
Half-press the shutter button or press the button to apply 
the setting.

The elements set to “AUTO” change to achieve the standard 
exposure depending on the brightness of the subject.

 – For elements that are not set to “AUTO”, you can change 
the value by simply turning the dial.

 – The elements set to “AUTO” are grayed out even if you hov-
er the cursor over them, so you cannot change the values. 
Press the button to change the settings.

IF YOU WANT TO SHOOT CASUALLY USING THE CAM-
ERA’S AUTOMATIC EXPOSURE FUNCTION, SET THE 
SHUTTER SPEED, APERTURE, AND ISO SENSITIVITY TO 
“AUTO”.
Use the  button to set each element (Shutter Speed, Aper-
ture, ISO Sensitivity) to “AUTO”.

CAUTION
 – If the image is too bright or too dark to achieve the standard 
exposure, the element set to “AUTO” flashes.
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TIP
 – If “Shooting Information” in the options menu (P.116) is 
set to “ON”, the exposure area and Color Mode information 
are displayed in the bottom row during the live view (the 
cursor is not displayed).

 – When the exposure area is selected, a histogram is dis-
played, which is useful for adjusting the exposure. For de-
tails on the histogram, refer to P.138.

 – For slow shutter speeds longer than one second, the Shut-
ter Speed turns red during exposure, and the time is count-
ed down until the exposure ends.

WHEN YOU ARE USING AN L-MOUNT LENS WITH AN 
APERTURE RING:
You can set the aperture value using the aperture ring on the 
lens.

CAUTION
If the lens aperture ring is set to any position other than A, the 
aperture value cannot be set on the camera. If you want to set 
the aperture value using the camera dial, set the lens aperture 
ring to position A.
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TIP
The exposure is determined by the relationship between three 
factors.

APERTURE
The aperture blades built into the lens adjust the amount of 
light that reaches the image sensor. A smaller number (opening) 
increases the amount of light, and a larger number (narrow-
ing) reduces the amount of light. A larger number (narrowing) 
increases the range in focus, and a smaller number (opening) 
reduces the range in focus.

SHUTTER SPEED
Adjust the amount of light according to the exposure time 
(Shutter Speed). A faster shutter speed enables you to freeze 
a fast-moving subject, and a slower shutter speed enables 
you to portray the movement of the subject. A slower shutter 
speed will make the image more susceptible to camera shake.

ISO SENSITIVITY
If you want to keep both the Aperture and Shutter Speed fixed 
when shooting, you can adjust the exposure by increasing or 
decreasing the sensitivity of the image sensor itself. The high-
er the ISO sensitivity (the larger the number), the easier it will 
be to capture darker subjects, which tends to increase noise in 
the image.
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SHUTTER ANGLE
In Record mode, you can switch the Shutter Speed to the 
Shutter Angle notation.
For the cinema camera, the shutter angle (angle) is generally 
used as the unit of exposure time in the shutter. For example, 
“360°” means that an exposure time of 100% is applied for 
each frame, and “180°” means that an exposure time of 50% is 
applied for each frame.

In Record mode, select the Shutter Speed and tap the tap but-
ton with the shutter angle expressed.

Shutter Angle OFF
(Default)

Expressed as the shutter 
speed.

Shutter Angle ON
The shutter speed is expressed 
as the shutter angle.
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EXPOSURE COMPENSATION
Use this function if you want to intentionally make the image 
brighter or darker than the appropriate exposure determined 
by the camera.

Move the cursor to the exposure compensation value and use 
the dial to set the degree of compensation.

The elements set to “AUTO” change according to the degree 
of compensation.

 – The degree of compensation can be set in 1/3 stop incre-
ments up to ±5 stops.

CAUTION
 – The exposure compensation is not canceled automatically. 
When shooting is complete, use the dial to return the degree 
of compensation to ±0.0.

 – The exposure compensation cannot be set when Shutter 
Speed, Aperture, and ISO Sensitivity are all not set to 
“AUTO”.

TIP
 – While the shutter button is being half-pressed, the exposure 
compensation can be set regardless of where the cursor is 
located in the main menu. (The status monitor always dis-
plays the exposure compensation.)

 – Different values   can be set for Still Image mode and Record 
mode.
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ISO AUTO SETTINGS
You can set the minimum and maximum values of the ISO sen-
sitivity for ISO Auto.
1
Select ISO and tap the ISO Auto Settings tap button when 
ISO is “AUTO”.

2
Use the buttons to select “ISO Auto Lower Limit” or “ISO 
Auto Upper Limit”, then use the buttons or dial to change 
the setting value.

ISO Auto Lower Limit ISO Auto Upper Limit

ISO 100 (Default) to 80000 ISO 125 to 102400 (Default)

TIP
 – Different values   can be set for Still Image mode and Record 
mode.
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LOW ISO SENSITIVITY EXPANSION
STILL IMAGE MODE ONLY
This function allows you to take multiple images at one time, 
produce the same status as the automatic synthesis or low 
sensitivity shooting, and shoot photographs with rich gradation 
and noises reduced.

If you select ISO and then tap the Low ISO Expansion tap but-
ton while (Low ISO Expansion ON) ISO is not set to “AUTO”, 
options are added in the expansion area (ISO80 to ISO6).

CAUTION
 – This function is not available when ISO is set to “AUTO”.
 – Image misalignment may occur when the subject is moving 
rapidly or when the shutter speed is slow.

 – The shutter speed selectable range and operating range 
vary between ISO6 and ISO80 depending on the ISO sen-
sitivity you set.
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SLOWEST SHUTTER SPEED LIMIT
You can set the lowest shutter speed limit and the shutter 
speed control tendency (faster, slower) when the shutter 
speed is set to “AUTO”.
1
Select Shutter Speed, and then tap the Slowest Shutter Speed 
Limit Setting tap button when ISO is “AUTO”.

2
Use the  button or the dial to set your desired shutter 
speed control type or the slowest shutter speed limit.

AUTO (SLOWER)
Set to a slower shutter speed than 
the standard by two levels.

AUTO (SLOW)
Set to a slower shutter speed than 
the standard by one level.

AUTO
(Standard) (Default)

Set to approximately one second 
of the focal length of the lens.

AUTO (FAST)
Set to a faster shutter speed than 
the standard by one level.

AUTO (FASTER)
Set to a faster shutter speed than 
the standard by two levels.

* 4s to 1/25600 Set to each shutter speed.

* In Record mode, the selectable shutter speed changes de-
pending on the frame rate setting.



50

 – When Shutter Angle is set to ON in Record mode, the fol-
lowing options are available.

Maximum Shutter Angle

AUTO (SLOWER)
Set the shutter angle two stops 
wider than the standard.

AUTO (SLOW)
Set the shutter angle one stop 
wider than the standard.

AUTO
(Standard) (Default)

Basically set the shutter angle to 
180°.

AUTO (FAST)
Set the shutter angle one stop 
narrower than the standard.

AUTO (FASTER)
Set the shutter angle two stops 
narrower than the standard.

* 1.1° to 360° Set to each shutter angle.

* The selectable shutter angle changes depending on the 
frame rate setting.

TIP
 – Different values   can be set for Still Image mode and Record 
mode.
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SPOT METERING
Normally, the evaluative metering is performed to divide the 
entire screen and calculate the exposure. Spot metering is 
useful when you want to adjust the exposure to a specific area 
only.

When an exposure area is selected, tap the Spot Metering tap 
button (Spot Metering ON) to switch to Spot Metering.

A circle indicating the metering range is displayed in the center 
of the screen.

To switch to the normal evaluative metering, tap the Spot Me-
tering tap button again (Spot Metering OFF).
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AE LOCK
This is a useful function when you want to temporarily fix the 
exposure and shoot at a constant exposure.

When an exposure area is selected, tap the AE Lock tap button 
(AE Lock ON) to fix the exposure at that time.

While AE Lock is ON, half-press the button; the icon indicating 
that lock is active is displayed on the left edge of the screen.

 – AE Lock is not released until you tap the AE Lock tap button 
again (AE Lock OFF) or turn the power off.

 – AE Lock is not available when all elements are not set to 
“AUTO”.
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EXPOSURE ASSIST
The camera has two tools that are useful to determine the ex-
posure.

When an element in the exposure area is selected, tap the Ex-
posure Assist button, and then use the button or the dial to 
select your desired tool.

OFF
(Default)

Exposure Assist OFF

ZEBRA Zebra Pattern

FALSE False Color

ZEBRA PATTERN
Displays the desired brightness range in a zebra pattern.

YOU CAN SET EITHER ONE OF THE FOLLOWING ZEBRA 
PATTERNS.
Select “Zebra Pattern” and use the button to enter the set-
ting screen. Use the  button to select an item, and use the 

 button or the dial to make settings.
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 – If you half-press the shutter button without entering the set-
ting screen, the zebra pattern is displayed with the previous 
setting.

 – Setting range: (0% = brightness value 0) to (100% = bright-
ness value 255)

 – You can select one of eight pattern colors or no pattern.
 – If the settings for the left and right zebra patterns are dupli-
cated, the zebra pattern on the left takes priority.

FALSE COLOR
The exposure status on the screen is displayed in different 
colors.

 – The displayed colors have the following meaning. The purple 
side indicates the underexposure, and the red side indicates 
the overexposure.

Purple 0 to 2.5%
Areas that are almost com-
pletely black

Blue From 2.5%
Areas that are about to be 
completely black

Green 18% GRAY
Areas that are almost com-
pletely appropriate (18% 
GRAY)

Pink
18% GRAY

+1STOP
Areas that are almost +1EV 
from the appropriate exposure

Yellow Up to 99%
Areas that are about to be 
overexposed

Red 99 to 100%
Areas that are almost com-
pletely overexposed
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MANUAL EXPOSURE
If you turn off “AUTO” for all elements (Shutter Speed, Aper-
ture, ISO Sensitivity), you can perform the shooting with man-
ual exposure. While watching the live view, adjust the values   to 
get the exposure you want.

YOU CAN ADJUST THE EXPOSURE, REFERRING TO THE 
VALUE ON THE EXPOSURE METER.
The exposure meter can display an exposure error of up to ± 5 
stops from the correct exposure in 1/ 3 steps. If the exposure 
error is more than three stops, the exposure meter will flash.

TIP
 – While the shutter button is being half-pressed, you can ad-
just the exposure no matter where the cursor is in the main 
menu. If the cursor is outside the exposure area, you can 
change the last element you operated in the exposure area. 
(The target element is displayed on the status monitor.)
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BULB SETTING
The shutter remains open when the shutter button is pressed 
all the way down. Use this function when you want to capture 
fireworks, starry skies, or light trails.

Deselect Aperture and ISO Sensitivity from “AUTO” and set 
them to your desired values, then set Shutter Speed to BULB.

CAUTION
 – When set to BULB, the exposure meter does not function. 
Use an external exposure meter to determine the exposure.

 – The maximum exposure time for bulb shooting is five min-
utes. The shutter will close automatically after five minutes 
even if you keep the shutter button pressed.

 – A long exposure may increase noise.
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DRIVE MODE
STILL IMAGE
Select a Drive Mode that matches the shooting scene, such 
as shooting continuously or shooting while changing the expo-
sure.

Select with the Drive Mode in the main menu.

Movie Movie

Still 
image

Single Capture 
(Default)

Can be 
combined with 
Self Timer.

Continuous

Exposure Bracket

Focus Bracketing

Interval Timer

SINGLE CAPTURE
When you press the shutter button, only one image is captured.
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CONTINUOUS SHOOTING
When you keep the shutter button fully depressed, the camera 
continuously captures images.
YOU CAN SELECT THE FRAME RATE FOR CONTINUOUS 
SHOOTING.
Select “Continuous” and use the button to select the frame 
rate.

8 FPS
Maximum approx. eight frames/sec. 
(Default setting)

5 FPS Maximum approx. five frames/sec.

3 FPS Maximum approx. three frames/sec.

CAUTION
 – Approximately 100 or more frames can be taken continu-
ously, but it may fall below 100 depending on the settings 
and shooting conditions.

 – When the number of frames that can be taken continuously 
falls below 50, the remaining buffer capacity is displayed. 
When the number reaches 0, shooting is no longer possible.
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EXPOSURE BRACKETING
By setting the exposure judged as appropriate by the camera, 
it is possible to continuously take pictures with the exposure 
bracketed.

Select “Exposure Bracketing” and use the button to enter 
the setting screen. Use the button to select an item, and 
use the button or the dial to make settings.

 – If you half-press the shutter button without entering the set-
ting screen, shooting is performed with the previous setting.

Bracketing 
Amount

Bracketing 
Number

Bracketing Order

Up to ±3 
steps in 
1/3-step 
increments

3 shots
5 shots

3 shots
5 shots

0 → - → +
Appropriate → Under → Over
- → 0 → +
Under → Appropriate → Over
+ → 0 → -
Over → Appropriate → Under

 – “3 shots” and “5 shots” take pictures one by one while 
shifting the exposure in the specified order.

 – “ 3 shots” and “ 5 shots” take pictures continuously 
while shifting the exposure in the specified order.

 – As for shooting with Autofocus, “ 3 shots” and “
5 shots” take pictures at the focus position that was AF-
locked in the first shot for the second and subsequent shots.
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 – When Shutter Speed, Aperture, and ISO Sensitivity are all 
not set to “AUTO”, the shutter speed changes focusing on 
the set shutter speed.

 – Exposure Bracketing can be combined with Exposure Com-
pensation. Bracketing is performed based on the compen-
sation value specified in Exposure Compensation.

CAUTION
 – Exposure bracketing is performed repeatedly without being 
canceled even after shooting. To cancel the function, switch 
the Drive Mode to another mode.
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FOCUS BRACKETING
This function allows you to continuously take photographs with 
the focus position bracketed based on the focus position.

Select “Focus Bracketing” and use the button to enter the 
setting screen. Use the button to select an item, and use 
the button or the dial to make settings.

 – If you half-press the shutter button without entering the set-
ting screen, shooting is performed with the previous setting.

Bracketing 
Amount

Bracketing 
Number

Bracketing Order

Up to ±10 
levels in 
one-step 
increments

3, 5, 7, 9, 11, 
13, 15 shots

0 → - → +
Appropriate exposure → Un-
derexposure → Overexposure
0 → +
Appropriate exposure → Over-
exposure
0 → -
Appropriate exposure → Un-
derexposure

 – The focus shift per step varies depending on the lens.

Half-press the shutter button to focus, then full-press to take 
pictures continuously while shifting the focus in the specified 
order.

CAUTION
 – The focus bracketing is performed repeatedly without being 
canceled even after shooting. To cancel the function, switch 
the Drive Mode to another mode.
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INTERVAL TIMER
It is possible to take pictures automatically at selected inter-
vals.

Select “Interval Timer” and use the button to enter the set-
ting screen. Use the button to select an item, and use the 

button or the dial to make settings.

 – If you half-press the shutter button without entering the set-
ting screen, shooting is performed with the previous setting.

Shooting interval Number of shots

1 sec. to 60 min. 2 to 9999 times

 – The total time until the last frame is taken is displayed on 
the settings screen.

Press the shutter button to start Interval Timer.

 – Once shooting starts, the screen displays the time until the 
next frame will be taken and the number of frames remain-
ing.

 – As for shooting with Autofocus, the second and subsequent 
frames are taken at the focus position that was AF-locked in 
the first shot.

 – If the shooting interval is set shorter, the next shot may start 
before you return to the shooting screen.

 – The exposure is re-metered each time a shot is taken. If 
you want to take the second and subsequent shots with the 
same exposure as the first, set M   mode or use the AE lock 
button to fix the exposure.

 – To cancel Interval Timer midway during shooting, press the 
shutter button.
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CAUTION
 – Shooting may be interrupted midway depending on the bat-
tery power level. Use of the USB PD adapter is recommend-
ed.

 – Interval Timer is performed repeatedly without being can-
celed even after shooting. To cancel the function, switch to 
another mode in “Drive Mode”.

 – Depending on the settings, the image processing may take 
time, resulting in an interval longer than the set time.
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SELF TIMER SHOOTING
Self Timer can be used together in each drive mode for still 
images.

On the “Drive Mode” screen, tap the Self Timer tap button 
and use the  button or the dial to make settings.

OFF
(Default)

Self Timer OFF

2s
The picture is taken about two seconds 
after you press the shutter button.

10s
The picture is taken about 10 seconds after 
you press the shutter button.

When Self Timer is set, the Self Timer icon is displayed.

Determine the composition and half-press the shutter button 
to focus. Press the shutter button further to activate Self Tim-
er. An electronic beep keeps sounding while Self Timer is ac-
tive, and speeds up to notify you two seconds before the timer 
expires.
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 – To cancel Self Timer, tap the Self Timer tap button on the 
“Drive Mode” screen to set to “OFF”.

 – If “Speaker Volume” or “Timer Volume” in the “Sound Set-
tings” options menu is set to “0%”, an electronic beep is not 
emitted.

 – If you want to cancel Self Timer while it is active, press the 
shutter button again.

The following operations are available depending on the com-
bination of each Drive Mode and Self Timer.

Single
Capture

One shot is taken after the timer starts.

Continuous

The camera switches to the “Self-timer 
Burst” mode, which takes multiple shots 
continuously with one release. This is 
useful for taking commemorative photos of 
large groups of people, or photos where it 
is difficult to control timing.

Use the  button to select “three shots” 
or “five shots” for the number of shots you 
want to take continuously.

After the timer is activated, continuous 
shooting starts.
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Exposure 
Bracketing

“3 shots “ “5 shots “
The timer is activated each time the 
shutter button is pressed, and the camera 
takes pictures one by one while shifting the 
exposure in the specified order.

“ 3 shots” “ 5 shots”
The camera takes shots continuously while 
shifting the exposure in the specified order 
after the timer is activated.

Focus 
Bracketing

The camera takes shots continuously while 
shifting the focus in the specified order 
after the timer is activated.

Interval Timer
The interval shooting starts under the set 
conditions after the timer is activated.
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FOCUSING
Set the focus mode and options according to the shooting 
scene and subject.

HOW TO USE AUTOFOCUS
1
Set the focus mode selector switch (if present on the lens) to 
AF mode.

2
Set the camera’s focus mode (P.68).

3
Half-press the shutter button to activate the Autofocus.
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FOCUS MODE SETTING
Select with focus mode in the main menu.

IN STILL IMAGE MODE

Single AF (Default)

Continuous AF

Manual Focus

IN RECORD MODE

Constant AF (Default)

Continuous AF

Manual Focus
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SINGLE AF
STILL IMAGE MODE ONLY
Available for a still subject. After the subject comes into focus, 
the focus point is fixed while the shutter button is being half-
pressed.

 – When the subject comes into focus, the focus frame lights 
up green and a focus sound is heard.

v

In case of Multi Auto Focus 
Points (P.76)

In case of One Point 
(P.75)

 – If the subject is out of focus, the focus frame flashes red.

In case of Multi Auto Focus 
Points (P.76)

In case of One Point 
(P.75)

 – The exposure is locked at the value when the shutter button 
is half-pressed.

 – When Continuous Drive Mode is selected, continuous 
shooting is conducted at the focus position of the first 
frame.
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FOCUS LOCK SHOOTING
After the subject comes into focus, you can change the com-
position for shooting while keeping the shutter button half-
pressed.

TIP
 – If you press the button while half-pressing the shutter 
button, the distance is re-measured using the focus frame 
of one point in the center.
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CONTINUOUS AF
Available for a moving subject. After the subject comes into 
focus, the camera continues to focus on the subject as long as 
the shutter button is half-pressed.

 – When the subject comes into focus, the focus frame lights 
up green, and the camera continues to focus on the subject 
as long as the shutter button is half-pressed.

 – If the subject moves off-screen, the camera re-measures 
the distance and focuses on another subject.

 – You cannot release the shutter until the subject comes into 
focus.

 – If the continuous shooting is selected, the AF activation and 
shooting are repeated. For the second frame and subse-
quent frames, the release takes priority and the picture may 
be taken out of focus.

 – The shot is taken at the exposure value that was set when 
the shutter button was pressed all the way down. (When 
recording movies, the exposure is controlled to always keep 
the standard value.)

 – Regarding shooting movies with the focus frame set to 
“Multi Auto Focus Points”, the camera generally keeps the 
focus on the captured subject, however, the subject in the 
center of the screen is given greater importance, so the tar-
get may move.
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 – When the focus frame is set to “One Point”, the camera 
keeps focusing at the focus frame position when recording 
movies. If the subject moves while the shutter button is half-
pressed, the camera continues to track the subject. Keep 
the shutter button half-pressed even while recording a mov-
ie. When you release your finger from the shutter button, the 
camera refocuses at the original focus frame position.

 – The focus is not locked.
 – The electronic beeping sound does not sound.

CAUTION
 – The focusing accuracy may reduce depending on the condi-
tions of the subject.

TIP
 – If you press the button while half-pressing the shutter 
button, the camera re-measures the distance with the focus 
frame of one point in the center and keeps focusing the sub-
ject.
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CONSTANT AF
RECORD MODE ONLY
AF activates even if the shutter button is not half-pressed, and 
continues to activate even when recording movies.

 – When you half-press the shutter button and the subject 
comes into focus, the focus frame lights up green, and the 
camera continues to focus on the subject while you keep 
half-pressing the shutter button.

 – If the subject moves off-screen, the camera re-measures 
the distance and focuses on another subject.

 – Regarding shooting movies with the focus frame set to 
“Multi Auto Focus Points”, the camera generally keeps the 
focus on the captured subject, however, the subject in the 
center of the screen is given greater importance, so the tar-
get may move.

 – When the focus frame is set to “One Point”, the camera 
keeps focusing at the focus frame position when recording 
movies. If the subject moves while the shutter button is half-
pressed, the camera continues to track the subject. Keep 
the shutter button half-pressed even while recording a mov-
ie. When you release your finger from the shutter button, the 
camera refocuses at the original focus frame position.
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 – The focus is not locked.
 – The electronic beeping sound does not sound.

CAUTION
 – The lens focus mechanism is always active, so the battery 
will run out quickly. Please be aware of the remaining bat-
tery power level.

 – The focusing accuracy may reduce depending on the condi-
tions of the subject.

TIP
 – If you press the button while half-pressing the shutter 
button, the camera re-measures the distance with the focus 
frame of one point in the center and keeps focusing the sub-
ject.



75

FOCUS FRAME SETTING
You can set the optimal focus frame to suit the subject condi-
tions, such as still or moving subjects.

Select with the button on the “AF Mode” screen.

1 Point

Multi Auto Focus Points (Default)

1 POINT
Set the focus frame to any position and adjust the focus of the 
subject. This function is available when the subject position is 
determined.

MOVING THE FOCUS FRAME
You can move the focus frame by pressing the button on 
the “AF Mode” screen.
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 – You can use the button to move it in each direction.
 – You can use the dial to move it in the specified order.
 – You can also move it by touch operation (tap, drag). The 
distance is re-measured immediately after moving. You can 
move it even while recording a video.

MULTI AUTO FOCUS POINTS
The camera selects the optimal focus frame and adjusts the 
focus. This is effective for moving subjects or subjects that are 
not in the center.

AUTO TRACKING MODE
If you tap the subject you want to focus on when Multi Auto 
Focus Points is set, the camera continues to focus on that 
subject without having to half-press the shutter button. (Auto 
tracking mode)

 – A gray focus frame is displayed during auto tracking.
 – The Auto Tracking mode is also available when recording 
movies.

 – If the subject you are tracking moves off-screen for a certain 
period of time, tracking stops.

 – Depending on the situation, the subject may move onto a 
different subject while being tracked.
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 – To cancel the Auto Tracking mode, move the subject you are 
tracking off-screen for a certain period of time or tap the 
Auto Tracking Cancel tap button.

CAUTION
 – Tracking may not operate properly under certain conditions 
such as when:

 – The subject moves too quickly
 – The subject is too small or too large
 – The level of brightness changes
 – The shooting environment is dark
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SUBJECT DETECTION
Detect humans and animals and preferentially focus on them.

On the “AF Mode” screen, tap the Subject Detection tap but-
ton, and use the button or the dial to make settings.

OFF
Sets to the normal AF mode
without performing detection.

Human + Animal
Detection

(Default)
Preferentially detects humans and 
animals.

Human Detection
Preferentially detects humans.

Animal Detection
Preferentially detects animals.

 – Detection is preferentially performed subject’s eyes.

WHEN THE FOCUS FRAME IS SET TO “MULTI AUTO FO-
CUS POINTS” (DEFAULT):

 – If a subject is detected, a gray focus frame is displayed. 
When you half-press the shutter button, the focus frame 
turns green (in focus). In  mode or  mode, the 
camera continues to track that subject.
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 – When multiple subjects are detected, a guide icon is dis-
played according to the setting. If the subject focused on 
is not the intended subject, you can use the  button to 
move to the focus frame of a different subject while contin-
uing to half-press the shutter button.

WHEN THE FOCUS FRAME IS SET TO “1-POINT”:
 – The camera focuses at the position of the focus frame as 
usual. If a person or animal is detected, a gray focus frame 
is displayed. While half-pressing the shutter button. you can 
use the button to move to the focus frame of a different 
subject. In mode or mode, the subject contin-
ues to be tracked while the shutter button is half-pressed.

CAUTION
 – Detection may not be possible in the following situations.

 – Part of the face is blocked by sunglasses, a hat, bangs, etc.
 – Dark or backlit scene.
 – The subject is significantly out of focus.
 – The subject is moving quickly.
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AF SHIFT
If the intended position is not focused on, press the button 
while half-pressing the shutter button to re-measure the dis-
tance.

 – Press the button to re-measure the distance at a posi-
tion farther away from the current focus position.

 – Press the button to re-measure the distance at a posi-
tion closer to the current focus position.

 – When the focus frame is set to “1-Point” in mode, 
the distance is re-measured with the focus frame currently 
displayed. With other settings, the optimal focus frame is 
selected to re-measure the distance.
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AF+MF
After focusing with Autofocus, you can turn the focus ring to 
fine-adjust the focus.

On the “AF Mode” screen, tap the AF+MF tap button and use 
the button or the dial to make settings.

OFF
When set to AF, the focus ring does not 
function.

AF+MF
(Default)

The focus ring can be operated while the 
shutter button is being half-pressed. After 
fine-adjusting the focus, press the shutter 
button all the way down to take the picture.

Constant
AF + MF

The focus ring can be operated at all times.

TIP
 – By default, “MF Auto Review” is set to ON to make focus-
ing in MF mode easier. For details, refer to the “MF Auto 
Review” section in “AUTO REVIEW”(P.84). If you want 
to change the Auto Review settings, first change the Focus 
mode to MF and then change the “MF Auto Review” set-
tings.
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MANUAL FOCUSING
1
Set the Focus mode selector switch (if one is on the lens) to 
MF. (Set the camera’s Focus mode to (Manual Focus) if the 
lens does not have the Focus mode selector switch (P.68).)

2
Turn the focusing ring on the lens to obtain a clear, sharp im-
age.

TIP
 – By default, the “MF Auto Review”(P.86) is set to ON to 
make focusing easier. For details, refer to the section on 
“AUTO REVIEW”(P.84).
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FOCUS PEAKING
Emphasizes the outline of the focused part on the subject in 
the display. This function is useful for focusing. For peaking, 
you can select easy-to-see colors depending on the subject.

On the “Focus Mode” screen, tap the Focus Peaking tap but-
ton.

Use the button or the dial to select the color of the focus 
peaking.

OFF 
(Default)

WH (white) BK (black) R (red)

YE (yellow) C (cyan) B (blue)
M

(magenta)

Use the button to set the sensitivity of focus peaking.
The setting range is ±3 steps. The standard is “0”. The display 
range is wider when set to the + side, and narrower when set 
to the - side.

 – The color of the focus peaking is the same as the focus 
peaking in the “AUTO REVIEW”(P.84).
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AUTO REVIEW
AUTO REVIEW SCREEN

1. Focus Peaking tap button
2. Remaining display time
3. Focus
4. Magnified position display
5. Scale bar
6. Infinity position
7. Minimum distance position

AF-S AUTO REVIEW
After AF-focused, you can check the focus status with the 
magnified display and focus peaking display while continuing 
to half-press the shutter button.

On the “ Mode” screen, tap the Auto Review tap 
button.
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Use the button or the dial to select the Auto Review dis-
play time for which the shutter button is half-pressed.

OFF
(Default)

Auto Review is not performed.

1s Displayed for about one second.

2s Displayed for about two seconds.

5s Displayed for about five seconds.

HOLD Displayed while half-pressed.

Use the button to select the color of the focus peaking.

Off WH (white) BK (black)
R (red) 

(Default)

YE (yellow) C (cyan) B (blue)
M

(magenta)

 – The magnification ratio of the zoomed-in view can be 
changed using the dial while Auto Review is active.

1X 2X
4X 

(Default)
8X

 – The image is enlarged around the focused focus frame.
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MF AUTO REVIEW
In Manual Focus mode, operate the focus ring or tap any point 
on the screen to make it easier to focus with the magnified dis-
play and focus peaking display.

On the “ Mode” screen, tap the Auto Review tap button.

Use the button or the dial to select the Auto Review dis-
play time for which the shutter button is half-pressed.

OFF Auto Review is not performed.

1s Displayed for about one second.

2s
(Default)

Displayed for about two seconds.

5s Displayed for about five seconds.

HOLD Displayed while half-pressed.

 – The display time is equivalent to the time from when the fo-
cus ring is not operated or when the focus ring operation is 
stopped.

Use the button to select the color of the focus peaking.

Off WH (white) BK (black)
R (red) 

(Default)

YE (yellow) C (cyan) B (blue)
M

(magenta)
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 – The magnification ratio of the zoomed-in view can be 
changed using the dial while Auto Review is active.

1X 2X
4X

 (Default)
8X

 – The image is enlarged around the center of the screen. If 
you tap the screen, the image is enlarged around the point 
you tapped.

CAUTION
 – The zoomed-in view, shooting distance display, and scale 
bar display using the focus ring are only viewed with com-
patible lenses.

TIP
 – While Auto Review is active, the time remaining until the 
display ends is displayed as dots.

 – To return Auto Review to the normal view during processing, 
or to return the Auto Review under HOLD to the normal 
view, press the button.

 – While Auto Review is active, you can turn the focus peaking 
display on and off using the focus peaking tap button.

 – The focus peaking color and sensitivity are common set-
tings for“FOCUS PEAKING”(P.83), AF-S Auto Review, 
and MF Auto Review.

 – The magnification ratio is the common setting between the 
AF-S Auto Review and MF Auto Review. The display time 
can be set separately for each.
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FOCUS RING CONTROL
You can change the focus movement amount relative to the 
focus ring control when using MF in Manual Focus mode.

On the “ Mode” screen, tap the Focus Ring Control tap but-
ton.

 – The name of the attached lens and the available angle range 
are displayed on the setting screen.

Use the buttons or the dial to select the rotation angle.

AUTO
(Default)

The focus movement amount changes de-
pending on the rotation speed of the focus 
ring.

90° to 720°
Approximate angle from infinity to the 
shortest shooting distance

MAX
Maximum angle that can be set with that 
lens

 – Angles marked with are not supported.

CAUTION
 – This setting is only available for compatible lenses.
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FOCUS LIMITER
Limits the focus operating range to accelerate the AF speed.

On the “AF Mode” screen, tap the Focus Limiter tap button 
and use the  button or the dial to make settings.

OFF
(Default)

Does not limit the operating range.

*
The focus operates only on the near side 
from almost at the center.

*
The focus operates only on the far side 
from almost at the center.

* The distance in the operating range is displayed on the set-
ting screen.

CAUTION
 – This setting is only available for compatible lenses. For de-
tails, please refer to the lens manual.
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LENS AFL BUTTON FUNCTIONS
You can customize the AFL button functions of the lens 
equipped with the AFL button.

On the “AF Mode” screen, tap the Lens AFL Button Function 
tap button and use the button or the dial to make settings.

AFL
(Default)

If you press the AFL button while AF mode 
is active, AF mode stops.*

AF-ON
If you press the AFL button, AF mode is 
activated.

* The AFL icon is displayed while AF is locked.
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IMAGE STABILIZATION
Configure settings for the Stabilization function.

Set with “Image Stabilization” in the main menu.

ELECTRONIC STABILIZATION
This function is only available in Record mode. This function 
generates a video with reduced camera shake while combining 
multiple frames before and after the target.

OFF
(Default)

Turns the Image Stabilization 
function off.

Electronic 
Stabilization

Turns the Electronic Stabiliza-
tion function off.

LENS OPTICAL STABILIZATION
This function allows you to turn the lens with the stabilization 
function installed on or off. When the Stabilization switch (OS 
switch, etc.) is provided on the lens side, operate the switch on 
the lens side.

 – For details on the Lens Optical Stabilization function, refer 
to the lens’s instruction manual.
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 – For lenses without the Image Stabilization switch, the “Im-
age Stabilization” option is added to the main menu in Still 
Image mode.

OFF
Turns the Image Stabilization 
function off.

Lens Optical 
Stabilization 

(Default)

Turns the Lens Optical Stabili-
zation function on.

 – For lenses without the Image Stabilization switch, the “Lens 
Optical Stabilization” option is added to the “Image Stabili-
zation” item in Movie mode.

OFF
Turns the Image Stabilization 
function off.

Lens Optical 
Stabilization 

(Default)

Turns the Lens Optical Stabili-
zation function on.

Electronic 
Stabilization

Turns the Electronic Stabiliza-
tion function off.

CAUTION
 – [Electronic Stabilization] cannot be simultaneously used 
with [Lens Optical Stabilization]. If the lens’s image stabi-
lization switch is turned on, Electronic Stabilization cannot 
be selected.

 – When shooting with the camera fixed on a tripod, turn “OFF” 
the Electronic Stabilization function.

 – When using Electronic Stabilization, the image is recorded 
in the range cropped to x1.25 (x1.96 when a DC lens is at-
tached).
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IMAGE FILE SETTING
Set the record format, aspect ratio, and crop mode for the still 
image to be recorded.

RECORD FORMAT
Select the image format.

Set with “Record Format” in the main menu.

DNG+J DNG+JPEG
Simultaneous recording of 
DNG (RAW format) and JPEG 
format

DNG DNG DNG (RAW Format)

JPEG
JPEG

(Default)
JPEG Format

 – The image size is recorded with 6,016 x 4,012 (at 3:2). 3,840 
x 2,560 (DC crop mode, at 3:2).
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TIP
 – DNG (RAW format) is a record format based on the materi-
al properties. Development process by SIGMA Photo Pro, 
etc. is required. SIGMA Photo Pro can be downloaded free 
of charge from our website. Sigma recommends that you 
always update SIGMA Photo Pro to the latest version.
sigma-global.com/en/support/software/

 – If necessary, you can create JPEG images from DNG 
images with the camera. Refer to “DNG DEVELOP-
MENT”(P.145).

 – DNG is the RAW image data that is developed by Adobe 
Systems Incorporated.
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ASPECT RATIO
Set the aspect ratio of an image.

Set the aspect ratio using the buttons or the dial in the 
“Aspect Ratio + DC Crop Mode” menu in the main menu.

21:9
Approximately the same aspect ratio as a 
widescreen movie.

16:9
Same aspect ratio as a high-definition 
television.

3:2
(Default)

Same aspect ratio as a 35mm film camera.

ASIZE
The aspect ratio is the same as the general 
A series paper size.

4:3
Same aspect ratio as a conventional televi-
sion or computer screen.

6x7
Approximately the same aspect ratio as a 
6x7 camera.

1:1
Square aspect ratio like that taken with a 
6x6 camera.

 – The image of each aspect ratio is cut and created from an 
image of the basic aspect ratio, “3:2”, of this product.

TIP
 – A DNG image can be changed to another aspect ratio using 
SIGMA Photo Pro or the DNG Development function of the 
camera.
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DC CROP MODE
When an APS-C format lens is attached, the image sensor’s 
recording range is automatically switched (Auto Crop). You can 
also manually switch the recording range.

Image circle of 
full size lens

Image circle of 
APS-C size lens

Full size image 
range

APS-C size image 
range

The DC Crop mode icon is displayed in DC Crop mode.

 – When a full-size lens is mounted and DC Crop mode [On] is 
manually selected, the peripheral areas in the image will be 
cut off, providing a telephoto effect of approximately 1.57x.

On the “Aspect Ratio + DC Crop Mode” screen, tap the Auto 
Crop tap button to turn “Auto Crop OFF”.

Use the button to set to “DC1.57x”.
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 – In DC Crop mode, the image is recorded at the size 3,840 x 
2,560 (at 3:2).

 – The record resolution does not change even in DC Crop 
mode.

 – When the APS-C format lens is attached, you can manually 
turn DC Crop mode OFF (1x). However, the periphery of the 
image may be vignetted black or not fully resolved.

CAUTION
 – Normally, use with “Auto Crop ON”.
 – With some lenses, you may not be able to manually switch 
the recording range.

 – With some lenses, Auto Crop does not work. In that case, 
switch it manually.
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IMAGE FILE SIZE
Below shows the approximate file size (MB) per image for a 
combination of each record format and aspect ratio.

 – The file size varies depending on the subject.

DC CROP MODE OFF (1X)

Aspect Ratio Number of Pixels DNG JPEG

21:9 16M (6016 × 2580) 35 11

16:9 20M (6016 × 3384) 46 14

3:2 24M (6016 × 4012) 54 16

ASIZE 23M (5672 × 4012) 51 16

4:3 21M (5348 × 4012) 49 15

6x7 20M (4980 × 4012) 45 14

1:1 16M (4012 × 4012) 37 11

DC CROP MODE ON (1.57X)

Aspect Ratio Number of Pixels DNG JPEG

21:9 6.3M (3840 × 1648) 15 5

16:9 8.3M (3840 × 2160) 19 6

3:2 9.8M (3840 × 2560) 22 7

ASIZE 9.3M (3616 × 2560) 21 7

4:3 8.7M (3408 × 2560) 20 6

6x7 8.2M (3184 × 2560) 19 6

1:1 6.6M (2560 × 2560) 15 5
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RECORD SETTINGS
Set the record format on the “Record Mode” screen in the 
main menu, and the resolution and frame rate on the “Record 
Settings” screen.

RECORD FORMAT
Set the record format of a movie.

Set on the “Record Mode” menu in the main menu.

H.264
H.264 Record

Best compatibility
(Default)

Highly versatile and 
available for viewing in a 
variety of environments.

H.265
H.265 Record

Best compression 
efficiency

A format that achieves 
high compression and 
high image quality.

L-LOG
L-Log Record

Best grading flexibility

A format with a wide 
dynamic range that is 
intended for editing.

 – Both are based on MOV format.
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L-LOG RECORD AND LOG GAMMA AUTO REVIEW
The L-Log record is a format intended for editing after shoot-
ing, the live view screen has a low contrast. You can shoot on a 
live view screen that reproduces the 709 Look so that you can 
easily see   what the final edited image will look like.

When the Record mode is set to “L-Log Record”, the main 
menu “Color Mode” changes to “Log Gamma Auto Review”.

L-Log Gamma 
View

(Default)

The live view screen displays the 
original L-Log gamma.

709 Look 
View

This is a live view screen that 
reproduces the 709 Look.

 – The Log Gamma Auto Review does not affect the recorded 
image.

CAUTION
 – Color mode (P.109) cannot be set for L-Log Record.
 – 709 Look View cannot be combined with the Exposure As-
sist.
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RECORD SETTINGS
Set with “Record Settings” in the main menu.

On the “Record Settings” screen, use the buttons to select 
“Resolution” and “Frame Rate”, then use the buttons or the 
dial to make settings.

RESOLUTION
Set the resolution (size) of a movie.

6K 6,016 x 3,384

UHD
(Default)

3,840 x 2,160

FHD 1,920 x 1,080

 – 6K cannot be used in conjunction with the following set-
tings:

H.264,  Electronic Stabilization,  DC Crop Mode

FRAME RATE
Set the frame rate (the number of frames per second).

 – The selectable frame rates are limited depending on the 
resolution.

23.98
FPS

25
FPS

29.97
FPS

50
FPS

59.94
FPS

100
FPS

119.88
FPS

6K 〇 〇 〇 ― ― ― ―
UHD 〇 〇 〇 ― ― ― ―
FHD 〇 〇 〇 〇 〇 〇 〇
〇 : Available  ―: Not available
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BIT RATE
The below table shows the correspondence between the mov-
ie bit rate (Mbps) depending on a combination of video record 
settings.

Resolu-
tion

Frame rate
(fps)

H.264 H.265 L-LOG

6K

23.98 ― 200 200

25 ― 200 200

29.97 ― 200 200

UHD

23.98 150 150 150

25 150 150 150

29.97 150 150 150

FHD

23.98 100 100 100

25 100 100 100

29.97 100 100 100

50 100 100 100

59.94 100 100 100

100 150 150 150

119.88 150 150 150
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WHITE BALANCE SETTING (WB)
In general use, the white balance is adjusted automatically; 
however, if the desired colors are not obtained, you can config-
ure a setting from the preset white balance.

Set with “White Balance” in the main menu.

Mode
COLOR 
TEMP.

DESCRIPTION

Auto
(Default)

-

Adjusted automatically. 
Use your camera in 
this mode for regular 
photography

Auto
(Lighting 
Source 

Priority)

-

Select this setting to 
allow the camera to 
automatically deter-
mine the appropriate 
white balance while 
valuing the color and 
atmosphere of the light 
source.

Incandescent
Approx. 
3000K

Under lighting of incan-
descent light bulb

Fluorescent
Approx. 
4100K

Under white fluorescent 
lamp

Manual -

Select this setting to 
adjust the white balance 
by setting the color 
temperature to a numer-
ical value.
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Daylight
Approx. 
5400K

Sunny outdoor location

Overcast
Approx. 
6500K

Cloudy outdoor location

Shade
Approx. 
8000K

Shaded area in sunny 
outdoor location

Custom -

Select this setting to 
determine the white 
balance based on the 
image taken.
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CAUTION
 – (Manual) can only be selected on the “White Balance” 
screen.

FINE-ADJUSTING THE WHITE BALANCE
You can fine-adjust each preset white balance.
1
On the “White Balance” screen, select the desired white 
balance and use the button to display the “White Balance 
Fine-Adjustment” screen.

2
Use the buttons or the dial to adjust the color tempera-
ture, and use the buttons to adjust the hue (M-magenta, 
G-green).

3
Press the button or half-press the shutter button to apply 
the setting.

 – The fine-adjusted white balance is set to (Manual) and 
displayed as the adjusted value in the main menu “White 
Balance”.

CAUTION
 – You cannot save multiple (Manual) settings. It is always 
overwritten by the last white balance you adjusted.

TIP
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 – The preset white balances on the “White Balance” screen 
are arranged in order of color temperature. The position of 

(Manual) changes depending on the adjustment value.
FINE-ADJUSTING THE AUTO WHITE BALANCE
When you make fine adjustments for Auto or Auto (Lighting 
Source Priority), the white balance is set to the value the 
camera determines to be appropriate, taking into account the 
adjustment amount.

SETTING A CUSTOM WHITE BALANCE
Select this setting to determine the white balance based on 
the image taken.
1
On the “White Balance” screen, select .

2
Under the lighting you want to shoot actually, place a white 
subject (such as white paper or a white wall) that you want to 
use as a reference in the frame at the center of the screen, and 
press the button.

If acquisition succeeds, the frame turns yellow. If acquisition 
fails, the frame flashes red. Press the button again.

3
Press the button to complete the setting and take the pho-
to.

 – The acquired custom white balance is displayed as the color 
temperature and hue values   and lined up in the White Bal-
ance column.

 – Up to 10 custom white balances can be saved. If the limit is 
exceeded, a message is displayed, so delete unnecessary 
custom white balances before acquiring one.

 – You can also fine-adjust the custom white balance.
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DELETING THE CUSTOM WHITE BALANCE
1
On the “White Balance” screen, select the custom white bal-
ance you want to delete, and tap the “Delete Custom White 
Balance” tap button.

2
Select “Delete Custom White Balance” and press the but-
ton.
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WHITE BALANCE LOCK
When set to Auto or Auto (Lighting Source Priority), this func-
tion is convenient for temporarily fixing the white balance and 
shooting with a constant white balance.

When you tap the “WB Lock” tap button on the “White Bal-
ance” screen (WB Lock ON), the white balance at that time 
will be fixed.

While the white balance is being locked, the icon indicating 
that the lock is active is displayed.

 – The white balance lock is not released until you tap the “WB 
Lock” tap button again (WB Lock OFF).
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COLOR MODE
You can select the desired Color mode depending on the 
shooting conditions. In addition to the above settings, Mono-
chrome photography or movie can be selected.

Set with “Color Mode” in the main menu.

STD.
Standard
(Default)

A basic color mode suitable for a 
variety of scenes.

RICH
Rich

Features high saturation and 
bright blues, resulting in a colorful 
finish.

CALM
Calm

The contrast is set low, creating a 
soft, calm atmosphere.

Pow B. 
Powder Blue

This mode is characterized by a 
refreshing blue color with a bright 
and transparent look.

W.GLD
Warm Gold

Expresses a deep atmosphere 
with calm tones and warm colors.

T&O
Teal and Orange

Highlights orange colors such as 
a flesh color and turquoise of a 
complementary color to empha-
size images.

FOV B. 
FOV Classic Blue

Expresses a deep blue and repro-
duces an impressive blue sky.

FOV Y.
FOV Classic Yellow

Expresses the deep and impres-
sive color tone with the yellow 
color emphasized.
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FOR G. 
Forest Green

Expresses greens such as plants 
more impressively with the green 
color emphasized.

SUN R.
Sunset Red

Expresses scenes such as sunsets 
more impressively with the red 
color emphasized.

CINE. 
Cinema

Expresses a movie-like image with 
reduced saturation and empha-
sized shadows.

709 
709 Look

A mode applied during L-Log 
shooting to reproduce colors close 
to human vision.

MONO.
Monochrome

You can take monochrome photos.

TIP
 – In SIGMA Photo Pro, Monochrome mode is designed for 
DNG data capture using MONO. SIGMA Photo Pro can 
convert Monochrome DNG images into color. (JPEG data 
cannot be returned to a color image.)

CAUTION
 – When developing DNG data with an Adobe Systems ap-
plication, the color mode settings may not be reflected de-
pending on the version of the application. Please check the 
up-to-date information.
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COLOR MODE DETAILED SETTING
For each color mode, you can adjust the image parameters 
(Look Effect, Highlight, Shadow, Fade, Vignette) to create your 
desired image.

In the color mode you want to adjust, use the button to se-
lect the parameter, and use the button to set the adjustment 
amount.

LOOK EFFECT (EXCLUDING MONOCHROME)
You can emphasize or suppress the characteristics of each 
color mode. Setting a positive value makes the effect stronger, 
and setting a negative value makes the effect weaker.

 – When you adjust the Look Effect, the adjustment value is 
displayed in the main menu “Color Mode”.

HIGHLIGHT
You can adjust the bright parts (highlights) of the image. Set-
ting a positive value makes the image brighter, and setting a 
negative value makes the image darker.
SHADOW
You can adjust the dark parts (shadows) of the image. Setting 
a positive value makes the image brighter, and setting a nega-
tive value makes the image darker.
FADE
Boosts blacks to create a softer impression. The more positive 
the value, the softer the impression.
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VIGNETTE
Reproduces the vignetting effect of a lens, emphasizing the 
subject in the center. The more positive the value, the stronger 
the vignetting effect.

TONE (MONOCHROME ONLY)
If you set Color Mode to Monochrome, “Look Effect” changes 
to “Tone”. You can create a monochrome image with a tint.

BW
Black and 

White 
(Default)

R
Red

WT
Warm 
Tone

SEP
Sepia

G
Green

BG
Blue 

Green

B
Blue

CT
Cold 
Tone

BP
Bluish 
Purple

P
Purple

TIP
 – For DNG data, you can change the color mode or adjust a 
parameter using SIGMA Photo Pro.

FILTER EFFECT (MONOCHROME ONLY)
You can change the contrast of monochrome images. For the 
filter color, the similar colors are expressed brighter, and the 
complementary colors are expressed darker.

If you set Color Mode to Monochrome, the main menu “White 
Balance” changes to “Filter Effect”.

OFF
(Default)

R
Red Filter

OR
Orange Filter

YE
Yellow Filter

G
Green Filter

B
Blue Filter

 – Normally, set to OFF.
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ENJOYING OLD LENSES
You can apply color shading compensation to lenses attached 
via a mount adapter or those without built-in compensation 
information and record the lens’s focal length in the image in-
formation.

COLOR SHADING COMPENSATION
This function enables you to compensate for color shading 
(phenomenon in which parts around the screen are colored).

ENTERING LENS INFORMATION
1
When a lens that does not have communication information 
with the camera is attached, “No Lens” is displayed in the Fo-
cus mode of the main menu.

2
Select Focus mode and use the button to select “Lens+”.

3
Use the  button or the dial to enter lens information (suf-
fixed by a symbol A to Z).

 – When you take a picture in this state, the entered informa-
tion is recorded in the image information. If you want to 
apply Color Shading Compensation, proceed to step 4.
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CAPTURING THE COMPENSATION SCREEN
4
After entering the lens information, press the button to dis-
play a message. Fill a monotonous screen without a color tone 
such as white or gray on the entire screen, and press the 
button.

 – If the compensation is successful, the square icon on the 
right edge turns white.

　

 –  If you want to reset the compensation data, press the Reset 
compensation data tap button, select “Reset Color Shading 
Compensation”, and confirm with the button.

 – Shooting and recording will continue with the same data 
until you change to the next L-mount lens.

 – If you want to register another lens, repeat steps 2 to 4.
 – If you want to shoot with a registered lens again, select Fo-
cus mode and use the button to select the lens.

 – After selecting the lens, press the button to modify the 
lens information and delete or reacquire the compensation 
data.

 – If you want to delete the registered lens information, select 
the lens, tap the Delete button, select “Delete Manual Lens 
Profile”, and use the button to apply the setting.
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USING THIS PRODUCT AS A WEB CAM-
ERA
This product can be used as a Web camera.
1
Connect the camera to your computer with a commercially 
available USB Type-C cable.

 – The “USB Mode Select” screen is displayed.

2
Press the button to select “UVC”, and press the button.

 – Switch between modes as necessary.
 – The unavailable items are displayed in dark gray.
 – The System Menu cannot be set.
 – For information on the camera or microphone setting, refer 
to Help or other references of the software you are using.

 – Depending on your software, you may need to set a reso-
lution on your camera. If this is the case, set it before con-
necting.

 – The following buttons are not available.

button

 – To exit UVC mode, select “Finish UVC Mode” in the options 
menu “USB Mode Select” and press the button.
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OPTIONS MENU
When shooting, you can set functions that are convenient for 
shooting as well as functions for deleting images and playing 
back images.

Pressing the button during live view will display the op-
tions menu for shooting.

1. Shooting Information
2. Center Mark
3. Guideline
4. Electronic Level
5. Focal Length
6. Focus

7. Monitor Settings
8. Sound Settings
9. Mic. Settings
10. USB Connection
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If you press the button when playing back an image, it 
displays the Options menu for deleting images and playing 
back images.

1. Delete
2. Rotate
3. Lock
4. Select Files
5. DNG Development
6. File Display Settings

7. Monitor Settings
8. Volume Settings
9. Mic. Settings
10. USB Connection
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Use the buttons to select the item you want to set.
For options that only have OFF/ON,use the button or the 
dial to change the setting to change the setting, press the 

button again or half-press the shutter button to apply the 
setting.
For options that have multiple choices, refer to the respective 
item.

 – For details on the Options menu for image playback, refer 
to each item in “REVIEWING, DELETING, OR SAVING 
IMAGES”(P.130).

SHOOTING INFORMATION
Displays the exposure area and color mode information (in-
cluding the remaining battery power level in Record mode, 
time, and remaining recording time).

OFF ON

CENTER MARK
You can display the center mark that identifies the center of 
the screen.

OFF ON
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GUIDELINE
Two types of guidelines are available to help you determine the 
composition.

OFF Grid Lines Aspect Ratio

 – Use the dial to select the desired guideline.
 – Selecting “OFF” does not display the guidelines.

GRID LINES
Displays grid-like guidelines. The numbers indicate the number 
of horizontal and vertical divisions of the screen.

 – Select “Grid Lines” and press the button, then use the 
button to select the desired number of divisions.

2 × 2 3 × 3 4 × 4

ASPECT RATIO
A frame guide that is useful for determining the composition 
can be displayed when shooting with different aspect ratios is 
taken into account.

 – Select “Aspect Ratio”, press the button, and then use 
the button to select your desired aspect ratio.

1.33:1 1.85:1 2.39:1
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ELECTRICAL LEVEL
Displays the horizontal and vertical tilt of the camera.

OFF ON

1. Horizontal indicator
2. Vertical indicator

When the camera is horizontal or vertical, the indicator turns 
green.

FOCAL LENGTH
Displays the focal length of the attached lens, or the focal 
length according to the operation of the zoom ring when a 
zoom lens is used.

OFF ON
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FOCUS
Displays the shooting distance (focus position).

OFF ON

MONITOR SETTINGS
You can adjust the brightness and hue of the LCD monitor.

BRIGHTNESS
You can adjust the brightness to make it easy to see depending 
on the surrounding brightness.

Select “Monitor Settings” and use the dial to set the bright-
ness for easy viewing.
Or use the buttons or dial to set the brightness on the 
“Monitor Settings” screen.

 – The brightness can be set to six levels from 0 to 5 (3 is the 
default).

OUTDOOR BRIGHTNESS ASSIST
Automatically increases the monitor brightness in bright loca-
tions such as under sunlight (Default).
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Tap the “Outdoor Brightness Assist” tap button to turn “Out-
door Brightness Assist ON”.

LCD OFF MODE
A mode that turns off the LCD monitor during shooting or 
when the camera is not being operated. This mode is useful 
when taking astronomy photographs.

Tap the “LCD Off Mode” tap button to turn “LCD Off Mode 
ON”.

 – You can also set separately the brightness for normal use 
when “LCD Off Mode” is “ON”.

 – The LCD monitor lights up for approximately three seconds 
when a button or dial is operated while the monitor is turned 
off.

 – The monitor does not turn off during playback, during 
zoomed-in view, or when each menu is displayed.
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HUE
You can adjust the screen hue “redness” and “blueness”.

Tap the “Hue” tap button, use the button to select “RED” 
or “BLUE”, and use the button or the dial to make adjust-
ments.

 – Normally set it to ±0.

SLEEP TIMER
You can set the time until the camera transitions to Sleep 
mode (P.31).

Tap the “Sleep Mode” tap button, and use the button or 
the dial to make settings.

OFF 10 sec. (Default)

30 sec. One min.

Five min. 10 min.

 – Setting “OFF” does not go into Sleep mode.
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CAUTION
 – If you set Sleep Timer to “OFF”, Auto Power Off (power 
OFF) is also not performed. Please be careful regarding the 
rate of battery consumption.

SOUND SETTINGS
Set the volume of each item.

SPEAKER VOLUME SETTINGS
Select “Sound Settings”, and use the dial to set the volume.
Or, on the “Sound Settings” screen, use the button or the 
dial to set the sound.

The volume can be set to six levels from 0 to 5 (3 is the de-
fault).
Setting 0 results in no sound.

EACH VOLUME SETTING
On the “Sound Settings” screen, press the button, and use 
the button to select the desired volume.

Shutter Volume AF Confirmation Volume

REC Volume Timer Volume

Use the button to set the volume.

 – The volume can be set in five levels from 0 to 100%.
 – Setting 0 results in no sound.
 – If Speaker Volume is set to 0, no sound will be heard.
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MIC. SETTINGS
You can adjust the sensitivity of the internal microphone while 
checking the audio being input on the audio meter.

 – This adjustment is only available in Record mode.

Select “Mic. Settings” and use the dial to adjust the sensitivity 
(adjustment is not possible during setting).
Or use the buttons or the dial to adjust the sensitivity on 
the “Mic. Settings” screen.

 – The sensitivity can be adjusted in the range from +6dB to 
-36dB in 3dB increments.

 – enables the camera to adjust to the optimal sensitivity 
(Default).

WIND NOISE CANCELLER
Reduces wind noises.

On the “Mic. Settings” screen, tap the “Wind Noise Cancel-
ler” tap button and set “Wind Noise Canceller ON”.
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USB CONNECTION
This camera can be connected to various USB devices. The 
settings that can be set in “USB Connection” in the Options 
menu change depending on the USB device you connect.

Setting Item Name / Connected Device Page

USB Mode Select
(PC)

Mass Storage - 126

UVC 126

(Cancel) - 26

USB Mic. Settings 127

USB Storage 149

USB Shooting Information (USB Monitor) 127

Cable Release -

USB Headphones 128

USB Headset Setting 129

USB Power Supply (Charger/Mobile bat-
tery)

26
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USB MIC. SETTINGS
You can adjust the sensitivity of an external microphone con-
nected via USB.

 – This adjustment is only available in Record mode.

Select “USB Mic. Settings” and use the buttons to adjust 
the sensitivity.
Or on the “USB Mic. Settings” screen, use the buttons or 
the dial to make adjustments.

 – The setting is not provided.
 – The Wind Noise Canceller setting is not provided.

CAUTION
 – Some devices do not allow you to adjust the microphone 
sensitivity.

USB SHOOTING INFORMATION
When using the USB monitor, you can set whether or not to 
display shooting information on the monitor.

OFF ON
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USB HEADPHONES
Set the headphone volume.

 – This is only available in Record mode when shooting.
 – You can set the volume separately for shooting and play-
back.

Select “USB Headphones” and use the dial to set the volume.
Or, on the “USB Headphones” screen, use the buttons or 
dial to set the volume.

 – The volume can be set to six levels from 0 to 5 (3 is the de-
fault).

 – Setting 0 results in no sound.

CAUTION
 – Some devices do not allow you to set the volume.
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USB HEADSET
Set the headset’s microphone sensitivity and headphone vol-
ume.

 – This is only available in Record mode when shooting.
 – You can set the volume separately for shooting and play-
back.

ADJUSTING THE HEADSET MICROPHONE SENSITIVITY
Select “USB Headset” and use the dial to adjust the sensitivi-
ty.
Or, on the “USB Headset” screen, use the buttons or dial 
to make adjustments.

SETTING THE HEADPHONE VOLUME FOR THE HEAD-
SET
On the “USB Headset” screen, use the buttons to set the 
volume.

 – The volume can be set to six levels from 0 to 5 (3 is the de-
fault).

 – Setting 0 results in no sound.

TIP
 – The headset microphone sound and the internal microphone 
sound are recorded on separate tracks.

CAUTION
 – Depending on the device, it may not be possible to adjust 
the microphone sensitivity or set the headphone volume.
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REVIEWING, DELETING, OR SAVING 
IMAGES

PLAYING STILL IMAGE

SINGLE CAPTURE
Press the button to display an image.

 – “File Order / File Count” is displayed on the status monitor.

 – For a movie file, the first frame is displayed.

DURING SINGLE-IMAGE PLAYBACK: 
 – Turn the dial to view the previous or next image.
 – Press the button or flick (drag) left or right on the touch 
panel to view the previous or next image.

 – Press the button or drag up on the touch panel to add 
shooting information display (P.137).

 – Press the button or drag down on the touch panel to 
switch to date display (P.136).
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TIP
 – If you hold down the button, the images are switched 
automatically. Pressing harder will skip 10 images for faster 
switching.

 – The first and last recorded images on the card are linked. 
Pressing the button while the first image is displayed 
brings up the last recorded image on the card. Pressing the 

button while the last image is displayed brings up the first 
recorded image on the card.

 – If there are no image files in the internal storage, the mes-
sage “No image” is displayed.

 – Whi le  reviewing images, pressing the button or 
half-pressing the shutter button will immediately set the 
camera to the shooting mode. 

CAUTION
 – The following image files may not be playable:
 – Image files taken with other cameras
 – Image files of which names have been changed
 – Image files outside the DCIM folder
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ZOOMED-IN VIEWING (STILL IMAGES ONLY)
Press the button during single image playback to zoom in 
on the image (10x).
Press the button during the zoomed-in view to return to the 
normal view.

Pinch out on the touch panel during single image playback to 
zoom in on the image.
Pinch in on the touch panel during zoomed-in view to zoom out 
the image.

The magnification rate changes as follows:
1x→1.25x→1.6x→2.0x→2.5x→3.15x→4.0x→5.0x→6.3x→8.0x
→10.0x

WHILE IN ZOOMED-IN VIEW:
 – Turn the dial to the right to zoom in, or to the left to zoom 
out. (You cannot use the dial to return to the normal magni-
fication.)

 – You can move the playback area by pressing the button 
or flicking (dragging) on   the touch panel.

CAUTION
 – Images cannot be switched during zoomed-in view. Return 
to the normal magnification by pressing the button or 
pinching out on the touch panel before switching.
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PLAYING BACK A MOVIE
When you press the button or tap the icon on the touch 
panel while a movie file is being displayed, a movie is played 
back.

 – The remaining playback time is displayed on the status 
monitor while the movie is playing.

DURING MOVIE PLAYBACK

Button/Dial Operation

Pause

Fast-forward playback

Fast-backward playback

Increases the playback volume.

Reduces the playback volume.

Dial
Fast-backward playback ↔ 
Fast-forward playback 

The playback speed increases each time the button is 
pressed or the Front/Rear dial is turned clockwise. (The play-
back speed decreases each time the button is pressed or 
the dial is turned counterclockwise.)
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PLAYBACK SPEED
X1→X1.2→X1.5→X2→X4→X8→X16→X32→X64→X128

 – In X1 to X2, a movie is played back with sound.
 – The speed in backward playback is X1.2 to X128 (audio will 
not play).

DURING PAUSE MODE

Button/Dial Operation

Playback

Frame-by-frame playback

Reverse frame-by-frame playback

Increases the playback volume.

Reduces the playback volume.

Dial
Reverse frame-by-frame playback 
↔ Frame-by-frame playback 

 – To exit the movie playback, press the button to select 
“Stop”, and press the button.
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CUTTING OUT A PHOTO FROM A MOVIE
You can create a photo of the desired frame from a movie file.
1
Play back a movie, and temporarily stop it in the target frame.

 – If you are not able to stop at the desired frame, use the 
button or the dial in Pause mode to perform frame-by-frame 
playback.

2
 – Press the button to select “Save as JPEG”, and press 
the button.

 – The file size varies depending on the setting of [Resolution] 
of the movie file.

6K 6016 × 3384

UHD 3840 × 2160

FHD 1920 × 1080

 – The created JPEG image is saved in the folder where the 
original movie file is saved.

 – The created JPEG image is shown with the mark in the 
shooting information (P.137).

 – The file number of the created JPEG image, which starts 
with “C__”, is assigned by the next number after the last file 
number in the folder.

CAUTION
 – If the storage does not have sufficient free space, a warning 
message is displayed, preventing you from saving the JPEG 
image. Follow the message instructions to free up space.
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DISPLAY BY DATE
The images taken that day are displayed as a list of thumbnails.

Press the button or drag down on the touch panel during 
single image playback.

 – The first 40 thumbnail images taken that day are displayed. 
If there are more than 40 images, the number of images that 
cannot be displayed as thumbnails is displayed in the posi-
tion of the last thumbnail image (if there are more than 999 
images, +999 is displayed).

When viewing by date: 
 – Turn the dial to display a list of thumbnail images of the pre-
vious or next date.

 – Press the button or flick (drag) left or right on the touch 
panel to display a list of thumbnail images of the previous or 
next date.

 – Press the button, press the button, or drag up on the 
touch panel to return to the single image playback.



137

VIEWING IMAGE INFORMATION
You can view detailed information for shooting.

Press the button or drag up on the touch panel during sin-
gle image playback.

 – There are three levels of image information. Each time the 
button is pressed, a row is added.

(Status with all image information displayed.)

1. Shooting Information
2. Shooting date and time
3. File information
4. Histogram (brightness)

5. Histogram (red)
6. Histogram (green)
7. Histogram (blue)

 – For a movie, the recording time is displayed in the Shooting 
Information column.

 – A movie has no histogram displayed.
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IN IMAGE INFORMATION VIEW:
 – Turn the dial to view the previous or next image.
 – Press the button or flick (drag) left or right on the touch 
panel to view the previous or next image.

 – Each time the button is pressed, the number of rows of 
image information decreases, and the display changes from 
the single image playback to the display by date.

 – To play a movie, press the button or tap the icon on 
the touch panel.

HISTOGRAM
The histogram is a graphic representation of the distribution of 
brightness in a picture. The horizontal axis shows the tone val-
ues from black (left) through gray to white (right). The vertical 
axis corresponds to the number of pixels at each brightness 
level. Accessing correct image exposure can be achieved by 
examining a histogram of the image.

Underexposure Correct exposure Overexposure

To display a histogram on this product, the brightness (totalized 
value of RGB), R (red), G (green), and B (blue) are displayed 
simultaneously at each level. (When an exposure area is se-
lected, only the brightness is displayed in the histogram.)
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DELETING FILES
1
Select the file you want to delete and press the button.

2
Move the cursor to “Delete” and press the button.

3
Select “Delete this File”, and press the button.

CAUTION
 – If the image is locked, “Delete” is not available. If you 
want to delete a locked image, release the lock.

 – Images recorded in DNG+JPG will be deleted along with 
DNG and JPEG images.

TIP
 – You can delete multiple files at once “PROCESSING MUL-
TIPLE FILES AT ONCE”(P.142).
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LOCK
Locking protects files from being accidentally deleted.

WARNING
 – Formatting a card erases locked files. Review card contents 
carefully before formatting.

1
Display the image you want to lock and press the button.

2
Move the cursor to “LOCK” and press the button.

 – A key icon will appear in the file indicating that the file is 
locked.

 – If the file is already locked, the menu item changes to “Un-
lock”.

 – To unlock an image, select the locked image and follow the 
same procedure as above.

 – Locked files have a “read-only” status when viewed on a 
computer.

TIP
 – You can lock multiple files at once “PROCESSING MULTI-
PLE FILES AT ONCE”(P.142).
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ROTATING IMAGES
STILL IMAGE ONLY
You can rotate the direction in which images are displayed.
1
Display the image you want to rotate, and press the but-
ton.

2
Move the cursor to “ROTATE”, and press the button.

 – Each time the button is pressed, the image rotates 90˚ 
clockwise.

 – Images rotated on the camera will be displayed in their ro-
tated orientation in SIGMA Photo Pro.

CAUTION
 – If “Horizontal Alignment” in the options menu is set to “ON”, 
you cannot select Rotate.

TIP
 – You can rotate multiple files at once “PROCESSING MUL-
TIPLE FILES AT ONCE”(P.142).
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PROCESSING MULTIPLE FILES AT ONCE
The following functions can be performed for multiple files at 
once.

Delete Rotate Lock

SELECTING A FILE TO PERFORM PROCESSING
1
Press the button while playing back a single image.

2
Move the cursor to “Select Files” and press the button.

3
Use the button to display the image you want to process 
and press the button (the icon turns white). Repeat this 
procedure to specify the image you want to process.

4
Press the button to select one of the functions “Delete”, 
“Rotate” or “Lock” and press the button.

 – For rotation, use the button to select the rotation angle 
(90˚, 180˚, or 270˚).

 – For lock, use the button to select Lock/Unlock.

5
Select “Selected files...” and press the button to apply the 
setting.

 – If you want to cancel, select “Quit” and then “Quit”.
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SELECTING AND PROCESSING BY DATE
1
Press the button while viewing the display by date 
(P.136).

2
Move the cursor to “Select Files” and press the button.

3
Use the button to display the date you want to process, 
then press the button (the icon on the left of the date 
turns white). Repeat this procedure to specify the date you 
want to process.

4
Press the button to select one of the functions “Delete”, 
“Rotate” or “Lock” and press the button.

 – For rotation, use the button to select the rotation angle 
(90˚, 180˚, or 270˚).

 – For lock, use the button to select Lock/Unlock.

5
Select “Selected files...” and press the button to apply the 
setting.

 – If you want to cancel, select “Quit” and then “Quit”.
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CAUTION
 – If “Horizontal Alignment” in the options menu is set to “ON”, 
you cannot select Rotate.

 – You cannot delete or rotate the locked image.
 – A movie cannot be rotated.
 – Rotation is performed with the added angles from the cur-
rent angle.

 – Either Lock or Unlock applies to all files regardless of the 
current status.
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DNG DEVELOPMENT
Without using a PC, it is possible for the Sigma BF to develop 
JPEG images from images recorded in DNG.

1. Exposure Compensation
2. Aspect Ratio
3. Fill Light
4. White Balance
5. Lens Compensation
6. Color Mode
7. Quit Icon
8. Development Icon

1
In Playback mode, select “DNG Development” from the 
options menu.(Only DNG format images are displayed.)

2
Display the image you want to develop and press the but-
ton.

3
Use the button to move the cursor to the item you want to 
adjust, and use the dial to change the adjustment value. (Move 
the cursor and press the button to move to the detailed 
setting screen for each item, where you can make the detailed 
adjustments.)

 – Touch or press the button to hide the information display 
and make the image easier to see.

4
If there are multiple items you want to change, repeat step 2.
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5
When you have completed the settings, select (development 
execution icon) and press the button.
6
Select “Develop” and press the button.
If you want to cancel, select “Cancel” and press the button.

 – The created JPEG image is saved in the folder where the 
original DNG image is saved.

 – The created JPEG image is shown with the mark in the 
shooting information(P.137).

 – The file number of the created JPEG image, which starts 
with “R__”, is assigned by the next number after the last file 
number in the folder.

CAUTION
 – If the storage does not have sufficient free space, a warning 
message is displayed, preventing you from executing the 
DNG development. Follow the message instructions to free 
up space.

 – It is recommended that SIGMA Photo Pro is used for fur-
ther detailed adjustment.

TIP
 – Fill Light: This function enables you to adjust the brightness 
so that dark parts become lighter, without changing the ex-
posure of light parts in an image.
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FILE DISPLAY SETTINGS
Set in  “File Display Settings” in the option menu in play-

back mode.

HORIZONTAL ALIGNMENT
You can specify the orientation to display the image.

OFF
(Default)

Displays in the orientation to take 
a picture.

ON Shows all files horizontally.

EXPOSURE WARNING
This function displays a red warning for a highlighted part in 
which a halation occurs on an image due to an overexposure.

OFF (Default) ON
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SAVING IMAGES TO THE COMPUTER
Transfer and save image files recorded in the camera to the 
computer.
1
Connect the camera to your computer with a commercially 
available USB Type-C cable.

 – The “USB Mode Select” screen is displayed.

2
Check that “Mass Storage” is selected, and press the but-
ton.

 – Or select “USB Mode Select” → “Mass Storage” from the 
Options menu.

 – The camera is recognized by the computer as a USB drive.

3
Copy or move the sub folder in which the image files in the 
DCIM folder are saved, or the image files in the sub folder, 
from your computer.

 – To disconnect, remove the hardware from your computer.

TIP
 – You can transfer images using SIGMA Photo Pro. For de-
tails, refer to the SIGMA Photo Pro help.

WARNING
 – If the computer enters Sleep mode during processing, the 
currently transferred data may be damaged. Configure a 
setting to prevent the computer from entering Sleep mode.
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SAVING IMAGES TO THE USB STORAGE
Transfer and save image files recorded in the camera to the 
USB Storage.

When the USB Storage is connected to the camera, a mes-
sage is displayed. Check that “Move to USB Storage” is se-
lected and press the button.

 – Or select “USB Storage” from the Options menu.

 – You can check the usage of internal storage on the “USB 
Storage” screen.

a
Total usage of USB Storage / Total capacity of USB 
Storage

b Total usage of USB Storage

TRANSFERRING IMAGES TO THE USB STOR-
AGE
You can select image files to transfer them, or select them by 
date to transfer them.

Transfer
Files are copied to the USB Stor-
age while the files are left in the 
internal storage.

Transfer and Delete
When images are transferred to 
the USB Storage, the images in 
the internal storage are deleted.

Quit Cancels the transfer.
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SELECTING A FILE TO TRANSFER
1
On the “USB Storage” screen, select “File Transfer”.

2
Display the image you want to transfer as instructed in “SIN-
GLE CAPTURE”(P.57), and press the button (the 
icon turns white). Repeat this procedure to specify the images 
you want to transfer.

3
Press the button to select “Transfer” or “Transfer and 
Delete”, then press the button.

4
Select “Transfer Selected Files” or “Transfer and Delete Se-
lected Files”, then press the button.

 – If you want to cancel, select “Cancel”.

SELECTING BY DATE TO TRANSFER
1
On the “USB Storage” screen, select “File Transfer”.

2
Press the button or drag down on the touch panel to dis-
play by date (P.136).

3
Use the button to display the date you want to transfer, and 
press the button (the icon on the left of the date turns 
white). Repeat this procedure to specify the date you want to 
transfer.
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4
Press the button to select “Transfer” or “Transfer and 
Delete”, then press the button.

5
Select “Transfer Selected Files” or “Transfer and Delete Se-
lected Files”, then press the button.

 – If you want to cancel, select “Cancel”.

CAUTION
 – If you select “Cancel”, the files are not transferred, but the 
files remain selected. If you want to completely cancel the 
transfer, select “Quit” → “Quit”.

FORMATTING THE USB STORAGE
If there is no free space on the USB Storage, you can format 
the USB Storage.

WARNING
You cannot check the files recorded on the USB Storage from 
the camera. Use a computer to check that no necessary files 
remain before formatting.

“USB Storage Format” → “Format USB Storage” → “OK”
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FOLDER NUMBER AND FILE NUMBER
The files you have taken are stored in a sub folder in the DCIM 
folder, which is named with the date they were taken.

FOR EXAMPLE, IF THE PHOTO WAS TAKEN ON DECEM-
BER 5, 2025...

Folder Sub folder File Numbering

DCIM

251205_0 BF_00001 to BF_09999

251205_1 BF_10000 to BF_19999

: :

251205_9 BF_90000 to BF_99999

251205A0 BF_00001 to BF_09999

: :

 – If the last four digits of the file number are greater than 
9999, a new sub folder with an incremented last number is 
created and the file will continue to be stored in the new sub 
folder.

 – The last number of the sub folder and the first number of 
the file number will be the same number.

 – If the last number of the sub folder exceeds 9, the under-
score changes to an alphabet (A to) and the last number 
restarts from 0. (File numbers restart from BF_00001.)
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 – If you shoot on a different date, a sub folder is created with 
the name of that day, but the same number is added at the 
end (the alphabetic part returns to an underscore). The file 
numbers are assigned with consecutive numbers.

(Example)

Shooting date Sub folder File Numbering

December 5, 
2025

251205_2 – BF_20795

December 7, 
2025

251207_2 BF_20796 –

 – The extension after the file number changes depending on 
the image format.

Still image
JPEG Format .JPG

DNG Format .DNG

Movie MOV Format .MOV

CAUTION
When the last sub folder number reaches Z9 and the file num-
ber reaches BF_9999, you cannot take any more pictures even 
if there is free space in the storage. Transfer the necessary 
images to your computer or an external storage, then initialize 
the internal storage or delete the last folder from your comput-
er.
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SYSTEM MENU

Configure the basic settings of the camera in the System 
Menu.

HOW TO OPEN THE SYSTEM MENU
Press the button to display the Options menu screen, use 
the button to select “SYSTEM”, and press the button.

IN THE SYSTEM MENU:
Use the button or the dial to select the item you want to set.
Use the button or the button to open a sub menu.
Depending on the item, a menu screen, a confirmation dialog 
or second-level items may be displayed.
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WHILE IN THE SUB-MENUS:
Use the button or the dial to select your desired option.
Press the or button to apply the setting.
(Press the or button to close sub-menus without 
changes being applied.)
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SYSTEM MENU LIST

Menu Item Second-level Menu Item Page
Information / Firmware - 157
Storage / File Manage-
ment

File Numbering Reset 158
Internal Storage Format 159

Copyright Information

Attach Copyright Infor-
mation

160
Photographer
Copyright Owner

Lens Optics Compensa-
tion

Diffraction Compensa-
tion

162

Optical Vignetting Com-
pensation

162

Shutter Blackout - 162
Sensor Refresh - 163

Adjust Electronic Level
Calibration

163
Reset

Date / Time / Area

Clock

164
Time Zone
Summer Time
Date Format
24-Hour Time

Language / Distance 
Unit

Language / 言語 166
Distance Unit 166

Settings Management
Save Settings 167
Restore Settings 167
Reset Settings 168

CAUTION
 – Depending on the camera settings, some menu items and 
setting options cannot be selected. They will be grayed out.
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INFORMATION / FIRMWARE
YOU CAN CHECK THE FOLLOWING INFORMATION 
ABOUT THE CAMERA:
Model name
Model number
Serial number
Firmware version

YOU CAN CHECK THE FOLLOWING INFORMATION 
ABOUT THE ATTACHED LENS:
Lens name
Lens serial number
Firmware version

YOU CAN CONFIRM THE AUTHENTICATION MARK.

TIP
 – The authentication information that is not printed on the 
camera is displayed on the bottom of the camera, on the 
packaging, in the instruction manual, etc.

FIRMWARE UPDATE
You can update the firmware for your camera and the attached 
lens.
For details on the firmware update status and update method, 
refer to our website.
sigma-global.com/en/support/
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STORAGE / FILE MANAGEMENT
You can check the usage of internal storage on the “Storage / 
File Management” screen.

a
Total usage of internal storage / Total capacity of in-
ternal storage

b Usage of still image file

c Usage of movie file

d Usage of other files

FILE NUMBERING RESET
The last four digits of the file number can be restarted from 
0001 at any time.

“Storage / File Management” → “File Numbering Reset” → 
“Reset File Numbering” → “OK”
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TIP
 – When reset, a new sub folder with the last number increased 
by one is created and the captured files are stored in the 
new sub folder. (The first number of the file number also 
changes.)

(Example)

Sub folder File Numbering

Before reset 251204_5 BF_50851

After reset 251204_6 BF_60001

INTERNAL STORAGE FORMAT
If you want to delete all image files or delete unnecessary files 
other than images, format the internal storage.

“Storage / File Management” → “Internal Storage Format” → 
“Format Internal Storage” → “OK”

WARNING
 – Formatting erases all card contents, including locked Sigma 
BF files and all non-Sigma BF files. Carefully check that no 
necessary files remain before formatting.
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COPYRIGHT INFORMATION
When shooting, you can record information about the “Pho-
tographer” and “Copyright Owner” in the Exif information.

 – Each item can be entered using up to 48 single-byte alpha-
numeric characters and symbols.

1
Select “Copyright Information” → “Attach Copyright Informa-
tion” → “ON”.

2
Select either “Photographer” or “Copyright Owner” and enter 
text following the steps in “How to enter text” below.

HOW TO ENTER TEXT

a. Input text display area
The text you entered is displayed. The cursor in the input char-
acter display area can be moved using the dial.
b. Keyboard area
Use the touch panel or the button to move the cursor, and 
use the button to enter text.
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A/a

Switches the keyboard to the alphabet.
When the alphabet is displayed, charac-
ters are switched between uppercase and 
lowercase each time this button is pressed.

123
Switches the keyboard to numbers and 
symbols.

Delete
Deletes the character to the left of the cur-
sor.

3
After entering all the characters, press the “ ” key to apply 
the contents you entered.

 – Pressing the “ ” key cancels the entry and returns to the 
“Copyright Information” menu.

 – If you do not want to record copyright information, select 
“Copyright Information” → “Attach Copyright Information” 
→ “OFF”.

 – If you want to delete the information you have entered, use 
the “Delete” key to delete all characters and then press the 
“ ” key to apply the setting.

TIP
 – You can review the recorded information in the Image Infor-
mation Window of SIGMA Photo Pro and by EXIF-compat-
ible software.

CAUTION
 – When lending or transferring the camera, set “Attach Cop-
yright Information” to “OFF”. It is recommended that the 
information in each entry item is deleted in such cases.
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 – We assume no responsibility whatsoever for any difficulties 
and/or damages resulting from the usage of copyright infor-
mation.

LENS OPTICS COMPENSATION
Specify whether or not to compensate for the following lens 
aberration.

DIFFRACTION COMPENSATION
Reduces the deterioration of the image quality caused by the 
aperture.

OFF (Default) ON

OPTICAL VIGNETTING COMPENSATION
Reduces the phenomenon in which the screen periphery dark-
ens.

OFF AUTO (Default)

SHUTTER BLACKOUT
Set whether or not to display a black image on the screen 
when the shutter button is pressed.

OFF ON (Default)
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SENSOR REFRESH
If a bright point is recorded in an image, perform Sensor Re-
fresh.
This optimizes shooting elements and image processing.

Close the cap, select “Sensor Refresh”, and press the but-
ton.

 – When the sensor refresh is complete, the camera will restart 
automatically.

CAUTION
 – If the sensor temperature is high or low, sensor refresh may 
not be available.

ADJUST ELECTRONIC LEVEL
Electronic level’s tilt can be adjusted.

Place the camera on a level surface, select “Calibration”, and 
press the button.
(The new adjustment value is recorded.)

To reset, select “Reset” and press the button. (The adjust-
ment value returns to the factory default.)
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DATE / TIME / AREA
If you have not used the camera for a long time, or if you are 
using it overseas, set the date, time, and area (region).

 – The shooting date and time information is recorded in the 
image file, so please set it correctly.

1
Select “Date / Time / Area”.

2
In “Time Zone”, select the area you want to use.

 – If there is no corresponding area, refer to the time difference 
from Coordinated Universal Time (UTC) and select an area 
with the same time difference.

3
Set the daylight saving time (summer time) as needed. In 
“Summer Time”, select “OFF” or “ON”.

4
In the Date/Time area, press the button or button to set 
the Date/Time.

5
Use the button to select each item, and use the button 
or the dial to make settings.
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6
Press the button to apply the settings. If you do not want to 
make changes, press the button.

CAUTION
 – The camera’s built-in clock runs on the electricity stored in 
the built-in rechargeable battery from the camera battery. 
If the battery has not been inserted in the camera for a long 
period of time and has not been charged, you need to reset 
the built-in clock.

 – If you change “Summer Time” after setting the time, the set 
time shifts by one hour.

TO CHANGE THE ORDER OF THE DAY, MONTH, AND 
YEAR
You can select the desired one from three date formats: Y/M/
D (year/month/day), M/D/Y (month/day/year), and D/M/Y 
(day/month/year).
In “Date Format”, select the desired display order.

TO SWITCH BETWEEN 24-HOUR TIME AND 12-HOUR 
TIME (AM/PM)
In “24-Hour Time”, select “ON” (24-Hour Time) or “OFF” (12-
Hour Time).
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LANGUGE / DISTANCE UNIT

SETTING THE LANGUAGE
You can set the language displayed on the menu screen, etc.

“Language / Distance Unit” → “Language / 言語 ”

You can select your desired one from 17 languages.

English
English
(Default)

日本語 Japanese

简体中文 Simplified
Chinese

한국어 Korean

繁體中文 Traditional
Chinese

Norsk Norwegian

Dansk Danish Polski Polish

Nederlands Dutch Português Portuguese

Suomi Finnish Русский Russian

Français French Español Spanish

Deutsch German Svenska Swedish 

Italiano Italian

SETTING DISTANCE UNIT
You can select the unit of shooting distance displayed in the 
shooting information.

“Language / Distance Unit” → “Distance Unit”

M (Meters) (Default) FEET
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SETTINGS MANAGEMENT
You can save multiple camera settings and restore any setting 
from multiple saved settings.

SAVE SETTINGS
You can save the current camera settings.

After you have set the camera to your desired settings,
select “Settings Management” → “Save Settings” → “Save 
Settings” → “OK” to save settings.

 – The saved settings are named with the date and time of 
saving, and up to 10 settings can be saved.

Example: 2025/10/25 09:15 32

RESTORE SETTINGS
You can restore any setting from multiple saved settings.
1
Select “Settings Management” → “Restore Settings” to se-
lect the desired setting from the list.

2
Select “Restore” → “Restore Settings” to restore settings.

 – When the restoration is complete, the camera will restart 
automatically.

 – You can select “Delete” → “Delete Settings” to delete the 
selected setting.
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RESET SETTINGS
All settings are reset, excluding the time.

Select “Settings Management” → “Reset Settings” → “Reset 
Settings” to reset the settings.

 – When resetting is complete, the camera will restart auto-
matically.

TIP
 – Even if you perform “Reset Settings”, the saved settings 
are not deleted.

 – When you perform “Restore Settings” or “Reset Settings”, 
the settings before the operation are automatically backed 
up (AUTO BACKUP) and you can return to the settings be-
fore the operation.

1
Select “Settings Management” → “Restore Settings” to se-
lect the “AUTO BACKUP” setting.

2
Select “Restore” → “Restore Settings” to restore the settings 
you backed up.

 – When the restoration is complete, the camera will restart 
automatically.
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REFERENCE

This section provides the optional accessories and the camera 
specifications.

OPTIONAL ACCESSORIES
HAND STRAP HS-11B / HS-11G
This strap has an adjuster that enables you to adjust the length 
to fit your wrist, enabling you to hold the camera firmly. The 
black strap (HS-11B) and gray strap (HS-11G) are provided to 
match the BF camera body color.

BATTERY CHARGER BC-81
This is a charger exclusively for the BF lithium-ion rechargea-
ble battery “Battery Pack BP-81” that supports USB PD (USB 
Power Delivery). Two BP-81 products can be charged at the 
same time.
* To charge with the BC-81 Battery Charger, please prepare 
the following items separately.
a: A commercially available USB Type-C cable (compatible 
with 3 A or more)
b: An external power source such as a commercially available 
USB AC adapter (compatible with USB PD (USB Power Deliv-
ery), Power source compatible with the output 9V/3A)

CR-51 CABLE RELEASE SWITCH
You can connect to the camera’s USB port to release the shut-
ter away from the camera. This is useful when you want to use 
a slow shutter speed or shoot a movie by attaching the camera 
to a tripod. (Cable length: Approximately 1m)
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TROUBLESHOOTING
If the camera is not working properly or the photos are not 
coming out well, check the following points before assuming 
that the camera is broken.

NOTHING IS DISPLAYED ON THE LCD MONITOR.
The battery power is depleted.

 ＞Replace with a charged battery.(P.26)
The LCD is in off mode.(P.123)

 ＞Half-press the shutter button or press any button.

CANNOT TAKE PICTURES.
The camera is placed under data processing (busy state).

 ＞Please wait until processing is complete.

AUTOFOCUS DOES NOT WORK.
The lens focus mode switch is set to M.

 ＞Set the lens focus mode switch to AF. (P.67)
The lens is not correctly attached.

 ＞Attach the lens correctly. (P.29)
The lens you are using does not support Autofocus.

 ＞Check the compatibility of your lens on the Sigma web-
site. (P.18)
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THE POWER TURNS OFF AUTOMATICALLY.
Auto Power Off is activated. 

 ＞The Auto Power Off function is activated to reduce the 
rate of battery consumption. If you are experiencing 
problems, set the Sleep Timer to “OFF” in the Options 
menu. (P.122)

CANNOT TAKE OR RECORD PICTURES.
The internal storage capacity is full.

 ＞Delete unnecessary images to free up space. (P.142)
The battery power is depleted.

 ＞Replace with a charged battery. (P.26)

THE DISPLAY AND IMAGE ON THE LCD MONITOR ARE 
UNCLEAR.
There is dust or dirt on it.

 ＞Blow it off using a blower or wipe it off using a soft, clean 
cloth. (P.19)

The LCD monitor is deteriorating.
 ＞Consult your dealer or the Sigma customer support.
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IMAGES ARE BLURRY.
You are taking pictures without focusing properly.

 ＞Half-press the shutter button and wait until the focus 
frame turns green before taking the picture.(P.69)

The lens focus mode switch is set to M.
 ＞Set the lens focus mode switch to AF.(P.67)

You are experiencing camera shake.
 ＞ Increase the ISO speed or fix the camera on a tripod be-
fore taking pictures. (P.41)

CANNOT ERASE IMAGES.
The images are locked.

 ＞Unlock them. (P.140)

THE SHOOTING DATE AND TIME ARE NOT DISPLAYED 
CORRECTLY.
The date and time are not set correctly.

 ＞Set the date and time correctly. (P.164)

AN ERROR CODE IS DISPLAYED.
An internal error has occurred, so shooting cannot continue.

 ＞Please contact the Sigma customer support.
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SPECIFICATIONS

Product Name Sigma BF

Type

Type
Interchangeable-lens Mirror-
less Type Digital Camera

Memory Media
Internal Memory (Approx. 
230 GB) , USB Storage (for 
Backup) 

Lens Mount L-Mount

Image 
Sensor

Type
35 mm full-frame (35.9 mm 
x 23.9 mm) Back-illuminated 
CMOS sensor

Camera Effec-
tive Pixels / 
Total Pixels

Approx. 24.6 MP / 
Approx. 25.3 MP

Aspect Ratio 3:2

Still Image File 
Format

Lossless compression RAW 
(DNG) 14-bit / JPEG (Exif3.0) , 
RAW(DNG) + JPEG: recording 
is possible

Image Aspect 
Ratio

[21:9], [16:9], [3:2], [A Size], 
[4:3], [6x7], [1:1]

File Size
RAW 6016 x 4012
JPEG 6016 x 4012

Crop
3840 x 2560
 (Equivalent to Approx.1.5 times 
the focal length)
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Movie 
Recording 
Format

Movie Format MOV: H.264, H.265, L-Log

Audio Format
Linear PCM
 (4ch 48 kHz / 16-bit: Max) 

Record Format 
/ Frame rate

6K* (6K: 6016 x 3384) / 23.98, 
25, 29.97 fps *Cannot be used 
in conjunction with EIS 
UHD 4K / 23.98, 25, 29.97 fps 
FHD / 23.98, 25, 29.97, 50, 
59.94, 100, 119.88 fps

Continuous 
Shooting 
Enable Time

2 hours

Focus

AF System / 
Focus Mode

Image Plane Phase-Detection 
AF + Contrast detection sys-
tem / Single AF, Continuous AF 
(with moving object prediction 
function), Manual Focus

AF Sensitivity 
Range / AF 
Mode

-5~18 EV (F1.4: ISO 100) 
1-Point AF, Area AF

AF Lock Half-press the shutter button

Other Focus 
Functions

Subject Tracking AF (Human 
+ Animal, Human, Animal) , 
AF+MF, Full-time AF+MF, MF 
Magnification  (Full Screen 
2x / 4x / 8x) ,  Focus Peaking, 
Focus Ring Control (Non-linear, 
Linear)
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Exposure 
Control

Metering 
System

Evaluative, Spot Metering

Metering 
Range

-7~20 EV (50mm F1.4: ISO 
100) 

Still Shooting

Program AE, Shutter Speed 
Priority AE, Aperture Priority 
AE, Manual 
*The above can be changed by 
setting each of Shutter Speed, 
Aperture, and ISO Sensitivity 
to Auto or Manual.

Movie
Shooting

Program AE, Shutter Speed 
Priority AE, Aperture Priority 
AE, Manual 
*The above can be changed by 
setting each of Shutter Speed, 
Aperture, and ISO Sensitivity 
to Auto or Manual.

ISO Sensitivity 
(Recommend-
ed exposure 
value)

Base ISO 
[Still] ISO 320 
[Movie] MOV: ISO 320, 
Log: ISO 1250 
 
Settable Range 
ISO 100-102400 / Expanded 
sensitivity ISO 6, 12, 25, 50

Exposure 
Compensation

±5 EV (in 1/3 stop increments) 

AE Lock Operated via touch

Exposure 
Bracket

3 shots, 5 shots stage ex-
posure ±3 EV (1/3 Step, 
Standard→Underexpo-
sure→Overexposure) (Se-
quence changeable)

Exposure 
Assist

Brightness Level Monitor 
(Histogram) , Zebra Pattern, 
False Color
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Image Stabilization System
Electronic Image Stabilization 
(EIS) for Video Only

White Balance

8 types 
(Auto, Auto [Lighting Source 
Priority] , Incandescent, Flu-
orescent, Manual [50K steps] 
, Daylight, Overcast, Shade, 
Flash) , Custom 1-10 settings 
can be added , AWB lock 
function

Shutter

Type Electronic shutter

Shutter Speed
1/25600 - 30 seconds, 
Bulb (up to 5 minutes)

Self Timer
2 sec., 10 sec. 
(Countdown Indicator)

Drive

Drive Modes

Single Capture, Continuous, 
Self-timer Burst, Exposure 
Bracketing, Focus Bracketing, 
Interval Timer

Continuous 
Drive Speed

Selectable frame rates 
(3, 5, 8 fps)

Number of 
Recordable 
Frames

JPEG: 1000 frames, 
DNG: 350 frames

Monitor
Type /
Coverage

TFT color LCD, Aspect Ratio 
3:2, 3.15 type, Approx. 2.1M 
dots , Electrostatic capacitance 
system touch panel / Approx. 
100%

Color Mode

13 types 
Standard, Rich, Calm, Powder 
Blue, Warm Gold, Teal and 
Orange, FOV Classic Blue, FOV 
Classic Yellow, Forest Green, 
Sunset Red, Cinema, 709 Look, 
Monochrome
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Other Function

Save / Restore Settings, Web-
cam, In-camera DNG Develop-
ment, Still image capture from 
recorded movie files, Fill Light 
(Supports only in-camera DNG 
Development)

Built-in Microphone / 
Speaker

Stereo Microphone / 
Monaural Speaker

Display Language

English, Simplified Chinese, 
Traditional Chinese, Danish, 
Dutch, Finnish, French, Ger-
man, Italian, Japanese, Korean, 
Norwegian, Polish, Portuguese, 
Russian, Spanish, Swedish

Interface

USB Type-C

USB 10 Gbps (USB 3.2) Com-
patible (Mass Storage, UVC, 
UAC, External Video Output, 
Charging / Power Delivery)

REMOTE Cable Release (via USB)
External 
Microphone 
Terminal

Supported via USB

Headphone 
Output
Terminal

Supported via USB

Dust and Splash Resistant 
Structure*

Provided
*Although this construction 
allows the lens to be used in 
light rain, it is not the same as 
being waterproof.
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Power

Power Li-ion Battery Pack BP-81
Number of 
Recordable 
Still Images

Approx. 260 images

Minutes of 
Recordable 
Continuous 
Shooting

Approx. 60 min.

Dimen-
sions and 
Weight

Dimensions
(W x H x D)

Approx. 130.1 x 72.8 x 36.8 mm 
/ 5.1 x 2.9 x 1.4 in.

Weight
Approx. 446 g / 15.7 oz. (in-
cluding battery) , Approx. 388 g 
/ 13.7 oz. (Camera Body Only) 

Operating 
Environ-
ment

Operating 
Temperature

32 to 104 °F / 0 to + 40 °C

Operating 
Humidity

85 % or less (non-condensing)

* The specifications are subject to change without prior notice.

SIGMA DIGITAL CAMERA
Model Name: BF   Model No.: C361
Input: 3.5V    Input (USB): 9V / 5V 
Made in japan

BATTERY PACK BP-81
Secondary Li-ion Battery   Model: BP-81
Nominal Voltage: 3.6V   Charging Voltage: 4.2V
Rated Capacity: 3300mAh   Rated Energy: 11.88Wh
Manufacturer: PT SIIX ELECTRONICS INDONESIA
Assembled in Indonesia
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BATTERY MANUFACTURING DATE
The battery manufacturing date is written in the lot number. 
The meaning of the lot number is as follows.

(Example) E B F B
①②③④

① Year of
manufacture

② Month 
of manu-
facture

③ Date of
manufacture

④ Revision 
code

E 2024 T 2035 A 1 G 7 1 1 B 11 M 21
D 2025 S 2036 B 2 H 8 2 2 C 12 N 22
C 2026 R 2037 C 3 J 9 3 3 D 13 P 23
B 2027 P 2038 D 4 K 10 4 4 E 14 R 24
A 2028 N 2039 E 5 L 11 5 5 F 15 S 25
Z 2029 M 2040 F 6 M 12 6 6 G 16 T 26
Y 2030 L 2041 7 7 H 17 V 27
X 2031 K 2042 8 8 J 18 W 28
W 2032 J 2043 9 9 K 19 X 29
V 2033 H 2044 A 10 L 20 Y 30
U 2034 G 2045 Z 31

Sigma Corporation
2-8-15 Kurigi, Asao-ku, Kawasaki-shi,
Kanagawa 215-0033 Japan
sigma-global.com/en/
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